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A. Preface

Purpose

This document describes the functionality and procedures involved in using the EVE
Screen Designer (ESD) 4.10

Intended Audience

The intended audience shall be any GUI application developer working with EVE
products.

Document Reference

Document Name Document Type Document Format
FT81x Series Programmers Guide Programming Guide PDF
FT81x Datasheet Datasheet PDF
FT9xx Toolchain Installation Guide Installation Guide PDF
BT81X Series Programming Guide Programming Guide PDF
BT81x Datasheet Datasheet PDF

Feedback

Every effort has been taken to ensure that the document is accurate and complete.
However any feedback on the document may be emailed to docufeedback@brtchip.com.
For any additional technical support, refer to http://brtchip.com/contact-us/.
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B. Overview

Introduction

EVE Screen Designer (ESD) is the next generation of smart IDE for EVE, making EVE-
based GUI development much easier to accomplish. This tool enables users to build one
GUI application using a visual programming' method without needing to know any
EVE-specific display list commands.

ESD provides a WYSIWYG ("What You See Is What You Get”) environment for editing
graphics, designing visual effects, and defining GUI application wuser logic,
generating ANSI C code for the targeted hardware platform. Users can also choose to
simulate the whole design to experience the UI before compiling and downloading the
generated source code. Furthermore, ESD has the capability to work seamlessly with
Bridgetek FT9XX tool chain. Users can compile, link the generated source code with
FT9XX tool chain and upload it to the targeted platform without leaving ESD.

A layout mechanism is introduced to manage widgets and pages in a more generic way.
The layout mechanism will enable users to create more dynamic UI much easier than
before. In addition, ESD 4.10 dramatically enhances the functionality of the logic nodes
editor, layout editor and project browser, for better user experience.

Key Features

The following are some of the key features of EVE Screen Designer:

WYSIWYG GUI

High level widgets

No EVE display list knowledge required

Widget based GUI construction

Drag and drop widget to create screen layout

Inter widget communication

Screen logic creation without coding

Simulation of screen logic and user touch input using mouse

Building and downloading the generated “C"” code (if FT9XX Toolchain is installed)

FEEFEERFEEF

What's new in ESD 4.10

New Features:

+ Adds support for EVE GPU BT817/8 based platforms (ME817-WH10C, ME817-
WH10C)

Enhanced UI of New Target Dialog

Allow users to configure the default empty project

Extend panning feature of Logic editor with Alt key and Left mouse press
Re-factor ESD Framework libraries

Sample project for video player added

Updated user guide with new platform details

FEFEEEE

! https://en.wikipedia.org/wiki/Visual_programming_language
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Bug Fixes:

Rectified build failure issue of exported Eclipse project.

Rectified build failure issue of emulator based MSVC exported project.
Fixed Build error when MM900X platform is selected

Fixed code generator for local method nodes.

Fixed screen widget bounding box for auto switch layout

Fixed bugs in example projects

Known Issues & Limitations

The following are some known issues and limitations of ESD:

FEEEFEE

= Only the BT81X/FT81X series EVE is supported. FT80X Series EVE is NOT
supported

= The C code editor in ESD does not support all the features of a code editor.

= If the project file path is too long (i.e. more than 512 bytes), ESD may have a
problem opening it. The typical error message is shown below:

“Unable to generate output files, check directory permission at:
C:\Users\xxxx.xxxx\Project\ESD\......

Where
“C:\Users\xxxx.xxxx\Project\ESD\...... » refers to the project folder.
= Logic node editor background goes white after system hibernates.
= In some unusual cases, users may encounter a dialog box (shown below) which

will not affect the functionality. In this case, just ignore the dialog box by closing
it.

! - 1| EmulatorProcess.exe has stopped working

Windows can check online for a solution to the problem.

# Check online for a solution and close the program
2 Close the program

= Debug the program

v View problem details

= In few cases, users may need to click [Recompile] at the toolbar to update the
frozen simulation result.
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Terms & Description

Abbreviations/Term Description

Actor

DLL

ESD
EVE Emulator
HAL

IDE
Layout type widget

Logic Node

Logic Node Editor
Page

Simulation
Widget

One type of logic node which is regularly updated but without visual
appearance

Dynamic Link Library is a collection of small programs, any of which can
be called when needed by a larger program that is running in the
computer

EVE Screen Designer

Bridgetek behaviour-modelling software for EVE Series chip

Hardware Abstraction Layer is a software subsystem providing hardware
abstraction.

Integrated Development Environment

One type of widget which has no visual appearance rendered by EVE ,
but manages the associated widget

The node expressing certain logic. (Also referred to simply as “node” in
this document)

The place where you create logic by connecting the logic node

One single screen in design

Preview the project or page by running the generated C code on PC
One type of logic node which has visual appearance rendered by EVE

Credits

Open Source Software

Qt: http://doc.qgt.io/gt-5/licensing.html under LGPL.
TinyCC: http://bellard.org/tcc/ and http://repo.or.cz/tinycc.git available under LGPL.

Errorlist module: https://qgithub.com/kaetemi/errorlist available under MIT license

QScintilla: part of PyQt available under PyQt commercial license

https://www.riverbankcomputing.com/commercial/license-faq

Icons Copyright

Some of the icons used in ESD 4.10 are from:
http://p.yusukekamiyamane.com/icons/search/fugue/

They are used in compliance with the Creative Commons Attribution 3.0 License.
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C. Setup & Installation

System Requirements

To install ESD 4.10 application, ensure that your system meets the requirements
recommended below:
v' Ideally Windows 10; alternatively Windows 8 or 7 with the latest windows
updates
1.6GHz or faster processor
1GB of RAM (1.5GB if running on a virtual machine)
Multi-Core CPU is highly recommended
At least 512MB hard disk space
Display resolution 1080x800 pixels or higher

AN N N AN

“Write” permission to the installation folder

Hardware Requirements

The exported C source code from ESD 4.10 is targeted at FT90X MCU Module and EVE
Module platforms.

The supported platforms are listed as below:

Platform Name Compatible EVE Module SRS (s il g

Module Name based Module
ME810A-WH70R(800x480
ME812A WH50R ME811A'WH7°REBOOX48°; Mmggg\éﬁf NA
ME812A-WH50R(800x480) aooEyTA
ME813A-WH50C(800x480) IMOOEy o
ME810A HV35R | ME810A-HV35R(320X480) NA
VM816CU50A VM816C (800x480) NA (”bgzzzzzzz )
FT4222
ME813AU WH50C = ME813AU WH50R(800x480) NA (libFT4553 dll)
VM816C50A VM816C (800x480) NA (IibIBI/IIESSS?EE )
MES17EV WH70C = MES17EV (1024X600) Mmggg\é;}llf (”bgjzzzzzz dl)
ME817EV WH10C = ME817EV (1280X800) mgggggﬁ (”b;r:222222 ai

While working on hardware platform (FT90X MM modules), users must ensure
that an SD card is inserted into the SD Slot since ESD 4.10 will try to detect the
presence of an SD card. If the SD card cannot be detected, then the application
may fail.
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Dependencies / Pre-Requisites \

e Visual C++ Redistributable for Visual Studio 2015

If the PC does not have Microsoft Visual Studio 2015 installed, Visual C++
Redistributable is required. Users can download this from:

https://www.microsoft.com/en-sg/download/details.aspx?id=48145

e Windows 10 Universe C Runtime

ESD 4.10 has run-time dependency on Windows 10 Universe C Runtime (CRT). You
may download it from https://www.microsoft.com/en-
us/download/details.aspx?id=48234 and install on your PC should the following
problem be encountered:

ScreenDesigner.exe - System Error ﬂ
The program can't start because api-ms-win-crt-runtime-11-1-0.dll is
migsing from your computer. Try reinstalling the program to fic this

problem.

Figure 1 - Screen Designer - System Error
¢ FT9XX Tool Chain Version 2.4.0 or later

To compile and build projects, the FT9XX Tool Chain 2.4.0 must be installed on the
PC. It is downloadable from http://brtchip.com/ft9xx-toolchain/.

Please ensure that the Tool Chain executable path is defined by the system PATH
environment variable.

Users are advised to check the known issues and limitations (of FT9XX Toolchain)
while building the ESD 4.10 project with FT9XX Toolchain. The respective FT9XX
Toolchain package version release note contains the list of known issues and
limitations.

For ESD 4.10, we recommend users to install FT9XX Tool Chain version 2.5.0 for the
best results.
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Installing ESD 4.10 Package \

The following steps will guide you through the ESD 4.10 Setup/Installation process.

i. Download the package from www.brtchip.com.

ii.  When prompted with a download dialog box. Click [Save].
iii. Navigate to the folder under which the package files are downloaded.

iv. Extract the zip file contents. Double click on the executable file - EVE Screen
Designer 4.10.exe

v. The EVE Screen Designer 4.10 Setup Wizard is displayed along with a Welcome
message.

ﬁ! Setup - EVE Screen Designer — b4

Welcome to the EVE Screen
Designer Setup Wizard

This will install EVE Screen Designer version 4. 10 RC3 on your
computer.,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

Vi. Click [Next] to view the end user information window.

ﬁl Setup - EVE Screen Designer — *

Information
Please read the following impartant information before continuing.

When you are ready to continue with Setup, dick MNext.

',E\"E Screen Designer 4,10 RC3 Release -

Featues:
WYSIWYG IDE
Logic node based Visual Programming method for screen logic creation
AMSI C Code generation for completed project
Live preview the designed project
Higher level widget and widget communication
Interactive widget
Extensible Widget Library
Tool Chain integration
Comprehensive example projects.
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vii.  Click [Next] to select a “Destination Folder” for installing the files. Accept the

default folder or click Browse to specify a different location. Click [Next] to
confirm the destination folder and continue.

ﬁ%‘ Setup - EVE Screen Designer — >

Select Destination Location
Where should EVE Screen Designer be installed?

Setup wil install EVE Screen Designer into the following folder.

To continue, didk Mext. If you would like to select a different folder, dick Browse.

‘C:'n,l_lsers'nPul:uIic'n,DDcuments'nE'l.-'E Screen Designer | E Browse... i

At least 226.2 MB of free disk space is required.

< Back Mext = Cancel

viii.  In the Select Components window, check “Install ESD essential Microsoft
VC++ redistributables (internet required)” boxes, to install runtime
components of Visual C++ Libraries. Click [Next] to prepare for the installation.

Product Page 12
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ﬁ'_:?'rl Setup - EVE Screen Designer — *

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue.

Custom installation Y

Install ESD essential Microsoft VC ++ redistributables (internet required) 14.3 MB

Current selection requires at least 240.4 MB of disk space.

iX. In the Select Additional Tasks window, check “Create a desktop / Create
Quick Launch shortcut” boxes, to have the ESD 4.10 icon and Quick Launch

shortcut displayed on the desktop if required. Click [Next] to prepare for the
installation.

ﬁ! Setup - EVE Screen Designer

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perfarm while installing EVE Screen
Designer, then dick Next.

Additional shortcuts:
Create a desktop shortcut
Create a Quick Launch shortcut

< Back ][ Mext = l[ Cancel
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X.  The initial setup is completed and the application is ready to be installed.

ﬁ' Setup - EVE Screen Designer — >

Ready to Install
Setup is now ready to begin instaling EVE Screen Designer on your computer.

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location:
Ci\Users\Public\Documents\EVE Screen Designer

Setup type:
Custom installation

Selected components:
Install ESD essential Microsoft VC++ redistributables {internet reguired)

Xi. Click [Install] to start the installation. First page progress bar indicates the
progress of the download of the MSVC C++ redistributable and the second page
progress bar indicates that the installation is in progress.

]f_."?'r! Setup - EVE Screen Designer — >

Downloading additional files
Flease wait while setup downloads additional files...

Total progress: 1.81ME of 14,16 MB (12%)
(3

Current file: 1.81 MB of 14,16 MBE (12%:)
3

File: vr_redist, k64, exe
Speed: 1.81 MB/s
Status: Downloading
Elapzed time: 1 second(s)
Remaining time: & second(s)
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ﬁ Setup - EVE Screen Designer I. = ﬁ]
Installing
Please wait while Setup installs EVE Screen Designer on your computer,
Extracting files...
C:Wsers\Public\Documents\EVE Screen Designer \ObjectWidgets. dil
|| |
b
Xii. In the Information page, Click [Next] to proceed ahead

ﬁ! Setup - EVE Screen Designer —

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, didk Mext,
Credits :

http: ffwww . han-soft. com
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Xiii. Upon successful installation, click [Finish].

ﬁ'_:’;' Setup - EVE Screen Designer | = ||

Completing the EVE Screen
Designer Setup Wizard

Setup has finished installing EVE Screen Designer on your
computer. The application may be launched by selecting the

installed shortcuts.

Click Finish to exit Setup.

¥| Launch EVE Screen Designer!
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Installation Folder |

The following table provides a list of folders that can be found under the installation path
upon successful installation of ESD 4.10.

Folder Name
Examples
Imageformats

Styles
Libraries

Log
Manual
platforms
Settings

Templates
TinyCC

Tools

Description

The example projects created by ESD 4.10
Qt run-time DLLs for image format
supporting

Qt run-time DLLs for UI styles

Widget library, application framework and
Hardware abstraction layer

Stores the runtime logs for debug purpose
Contains this document

Qt platform specific run-time DLLs
Configuration files for third-party utilities
and tool chains as well as ESD settings.
The files are in XML format.

The template files used by ESD

TinyCC run-time used for ESD simulation
purpose.

The third-party utilities used in ESD 4.10
for bitmap conversion purpose

Table 1 - Installation Folder

Permission
Read/Write
Read-Only

Read-Only
Read-Only

Read/Write
Read-Only
Read-Only

Read-Only.
Reserved for advanced users
to change.

Read-Only
Read-Only

Read-Only
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Users can refer to EVChargePoint examples in the path <ESD Folder>/Examples/
Advanced/EVChargePoint. Opening it may take more than 5 minutes because of ASTC,
bitmap and font conversion. This example contains all of the new BT81X features. Here

are the details:

1. Apply ASTC Bitmap Format for images and fonts.

Value

Bitmap

o COMPRESSED_RGBA_A!

.png
FlagEN.png
FlagRU.png

Value
urce File Proxy)
lame Resource:

Font

Format EXTENDED_ASTC
Font Size 24

Fiure 2 - ASTC applied for images and fonts

2. Resources are stored and loaded from flash.

Property Value
(R

~ Il Resources

nScreensaver.bin ESD_RESOURCE_DIRECTFLASH
False

een.png J False

d.png
B BtnCharge.png

Value

( urce File Pro;
File Name Resources/BtnCharge.png
Nare Bitmap
Category
Format COMPRESSED_RGBA_ASTC._...
Cormpressed False

v True

Cell Names i]

Figure 3 - Load resources from flash

18
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3. Use Unicode font with ASTC format and predefined character set

scBold24. otf
Light24,otf

ansDisplayLight24 ttf

SansDisplayRegularl.ttf

Value

File Name sz/MotoSansCIKscRegularlb.otf
MName Font

Category

Format EXTENDED_ASTC

Font Size

Character Set

source Type

ESsEd

Do et
Persisten

Figure 4 - Use Unicode font with pre-defined character set

FEEA...

o>— I

R 76 250
\\ RER FRES
| 2L 120

//v
_ 7— %

Figure 5 - Chinese font used in application

Support for ASTC bitmap format \

In ESD 4.10, images can be converted to ASTC bitmap format
to save a lot of storage space while image quality is still

retained.

PALETTEDS65
PALETTED4444
PALETTEDS

DXT1

Figure 6 - ASTC Format

Product Page
Document Feedback

19
Copyright © Bridgetek Pte Ltd


http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

B d k BRT_AN_029 EVE Screen Designer 4.10 User Guide
{ rl gete Version 1.0

BRIDGING TECHNOLOGY

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Support extended for font format and Unicode font \

Unicode font file can be added to a project by clicking File -> Add from the menu bar
and in the Property window, input font size and character set as desired.

Properties

Value
urce File Pre
File Mame Resources/KaoriGel .tf
Mame Font
Category
Format EXTEMDED_ASTC

Font Size

v True
False

Figure 7 - Font size and Character set

Once the font resource is ready, add a widget, such as ESD Label, ESD Button to
project. In Property window, select appropriate Font Resource.

Properties
Value

ESD Label
Static
0.00

v True

Width
Height
Auto

Alpha
Font

Font Resource

Figure 8 - Select Unicode Font Resource

BRELSTENET
BRESITENET

Cood morning

- C C \ ,_:':

Figure 9 - Unicode font applied for Label and Button

20
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Generate Flash file and write Flash file to device \

Resources can be loaded from flash or RAM_G. ESD 4.10 can generate Flash file for

BT81X projects, then uploads the Flash file to the device by pressing the #®~Build and
Upload to Hardware” button.

Properties

Value

Resources/Lenna_120.jpg
Name Bitmap
Category
Format COMPRESSED_RGBA_ASTC 5x5_ ~
v True
v True
0
0

Width

Figure 10 - Mark resource as storage in Flash

Run Executable

Upload Flash and Run Executable

Figure 11 - Upload Flash file to device

Restructured EVE HAL Library

EVE HAL Library is simplified. It contains C source files, and a sub-folder “Hdr” that
comprises of the C header files.

Additional layouts and widgets

The following layouts and widgets have been added -

e ESD Arc Slider, ESD Circular Slider
e ESD Ring, ESD Partial Ring

Ul enhancements

The following User Interface related enhancements has been added to ESD 4.10 -

Filter for Library Browser and Project Browser window

)
¢ More comprehensive toolbar buttons for platform description
¢ New menu to clean up unused/generated files in project
e Simplify the process of adding new resources into project
e Added context menu for document tab
Product Page 21

Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

Y .
< Brldgetek BRT_AN_029 EVE Screen Designer 4.10 User Guide
0.‘

*

BRIDGING TECHNOLOGY Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Impacts of ESD 4.10 updated features \

Since the new/updated features of ESD 4.10 may cause API changes, existing ESD 3.0
projects are not fully compatible with ESD 4.10. Although ESD 4.10 has the utility inside
to detect and migrate opening ESD 3.0 project, it may still not work as expected.

ESD Layouts: A new category of widgets “"ESD Layout” are introduced into the Library
Browser, which enables the layout feature.

ESD Widgets: A new set of widgets are introduced into "ESD Widgets” category in the
library. These set of widgets are to be used in constructing the pages. The nodes
under the “"ESD Render Functions” are not supposed to construct page as it has no
widget interface and the layout widget is unable to manage them.

Migrating from ESD 3.0 to ESD 4.10 project \

When ESD 4.10 opens an existing ESD 3.0 project, it will prompt users to migrate to the
latest version. If user chooses not to migrate, ESD 4.10 will not open ESD 3.0 project.

MIGRATION NOTES

1. Please back up your project if you are not sure about the migration. The migration

process will overwrite the project and it cannot be reversed.

The migrated project file will be renamed from “*.esd3"” to “*.esd”.

. The target module of the opened project will be redirected to two built-in platforms
after migration. So if the target module is in 320 x 480 resolutions, users may select
the platform *"ME810A HV35R” from “Build Target” combo box from the toolbar and
make a platform switch.

W N

VM316CU50A ~ [ yma16C = ElFra222 - [[@wz2sQ128 -

Build Target

In some cases, if an existing ESD 3.0 project cannot be migrated to ESD 4.10, then
users are required to migrate manually.

e The variable "Parent” of logic is renamed to "Owner”
in ESD 4.10.

e X, Y, Width, Height properties in widgets is now ||
accessible through the widget variable. 8 FT_Eve Halesd

o Instead of pointer, struct "Ft_Esd_BitmapCell” shall Sl
be used by value in ESD 4.10. ( ]

e In order to restore the default behaviour of
application logic “App.main”, users may need to
manually move the existing pages into layout widget
"Switch Page” in the Project Browser.

[ Main Page
2] MainPage.page
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Setting Platform Specific Properties \

ESD 4.10 users are able to create one project supporting multiple platforms with various
screen size. Therefore, on different platforms, the same widget may have a different
property value. For instance, for a platform with screen size 480 x 320, the button size
may shrink to a smaller size from the original value for a platform with screen size 800 x
480.

Users can make a property value specific to the current target through the context menu
of the property browser. This can be done by right clicking the selected property of the
current widget. This is illustrated in the picture given below -

Properties
Property Value
(ESD Label)
Name ESD3 Label
Allocation Static
Depth Sort 0.00
Active v True
X 176
¥ Make value specific to current target 85
Width Reset to default value 120
Height 36
Auto Resize ESD_AUTORESIZE_HEIGHT
Theme Ft_Esd_Theme_GetCurrent
Font 31
ESD3
OPT_ALIGN_LEFT
OPT_ALIGN_TOP

Figure 12 - Making Value Specific to Current Target

User can remove value specific to current target through context menu in property
browser by right clicking the selected property of current widget. This is illustrated in the
picture given below -

Properties
Property Value
(ESD Push Button)
Mame ESD Push Button 4
Allocation Static
Depth Sort 4.00
Active v True
b4 196

Y
Width Reset to default value 120

Remove target specific value 439

Height 36

Theme Ft_Esd_Theme_GetCurrent
Font 27

Text Bottomn Right

Primary ¥ True

Figure 13 - Removing Target Specific Value

"

Users can refer to the “ScreenResolution” project under the “Installation/Example
folder.
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Migrating existing projects to new platform

All the existing projects may have been developed using a specific platform. Users can
choose to migrate projects to a different platform by selecting the appropriate “Build
Target” combo box. If the desired target is not available in the “Build Target” Combo
box, then the user can configure the individual specifications (“Eve Platform”, “Display
Resolution” and “Host Platform™) of the target by selecting the appropriate combo boxes.

E. Getting Started

The Graphical User Interface

ESD 4.10 user interface has the following components:

Menu Bar
Toolbar
Project Explorer
Screen Layout Editor
Logic Node Editor
Library Browser
Error List/Inspector
Output window
Property Editor

0 Status Bar

HOoONOOTUNWNE

_Conditional Flow

#-1) Check the Option or not Option

2) Push the Button M

3) Result depending on Option

Option was checked! Option was not ciiecked!

EITMAP_HANDLE: o

Figure 14 - EVE Screen Designer 4.10 User Interface Components
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The ESD 4.10 Menu bar displays the headings for each drop-down menu. According to
the function, the commands are grouped under each of these menu headings.

menu bar File Edit Build Tools View Help
menu item = » B Logic
selected B Actor
& | Widget
™ Page
menu item il & Theme
MNew Project B SourceFiles

Open Project B Logic Source Files
40-

Close Project
Clean and Close Project
- B0-
as Eclipse Project

Launch Eclipse

1: MewProject? .esd

2 WindowLayout.esd
3: ScrollPanel.esd
Exit
Figure 15 - Menu bar

The following table provides the list of Menu/Submenu and its description -

Menu  Submenu Description
File New Logic
Actor
Widget
Page
Theme | creates new file for the current project
Source
Files
Logic
Source
Files
Add To add existing file(s)/resource (such as bitmap, C source
file etc.) to the project
Save To save the current file
Close To close the current file
Save All To save all the files in the current project
New Project To open a nhew project
Open Project To open an existing project
Close Project To close a current project
Clean And To clean current project then close it
Close Project
Export as To export as Eclipse project
Eclipse
Project
Export as To export as MSVC project
MSVC
Project
1:<Project To open recent project
Product Page 25
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Path>
Exit To close the ESD 3.1 application
Edit Undo To reverse the action of an recently performed action
Redo To revert the effects of the undo action
Cut Cut the selected node(s) to clipboard
Copy Copy the selected node(s) to clipboard
Paste Paste the node(s) from clipboard
Find Find a specific text string in source editor
Replace Replace a specific text string in source editor
Build Build To generate a executable file
Executable
Build and To generate a executable file and upload to hardware
Upload to
Hardware
Browse to To navigate to the folder under which the executable file is
Executable located
Tools Generate To generate a Class ID for user widget or layout. It is a
Class ID hash from the widget name and generally useful when
user prefers to write code in “"C” language.
Silibi nd its hash value
View Project
Library
Properties To display or hide a component view. By default all the
Inspector components are displayed.
Error List
Output
Help User Guide Opens the ESD 4.10 User Guide with respect to current
version
About Displays the version details
31 Party Displays the copyright, disclaimer and license information

of the 3™ party software

Table 2 - Menu & Description

Toolbar

The Toolbar provides easy access to common functions (in the form of icons) such as
new file, save file, undo, redo etc.

New Save Undo Simulation Recompile

Add Save Redo
All

Figure 16 - Toolbar 1

Restart
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Platform
Target

VMB16CUS0A - [ yma16C

Flash Chip
Type

Screen
Size

Toolchain Programmer

-

~ B wvea (goox ~ | EIFT4222 ~ | @ w250128

EVE Module MCU Platform Build Build and
Type Type Executable Upload to
Hardware

Figure 17 - Toolbar 2

The following table provides the list of toolbar functions and its description -

Toolbar Function
New

Add

Save
Save All
Undo
Redo
Simulation

Restart
Recompile

Platform Target
EVE Module Type
Screen Size

MCU Platform Type
Flash Chip Type
Build Executable
Toolchain

Build and Upload
to Hardware

Programmer

Description

To open new Logic/Actor/Widget/Page/Theme/Source Files/Logic Source
Files

To add existing resource (such as bitmap, C source file etc.) to the project
To save the currently open file

To save all the files in the current project

To reverse the action of a recently performed action

To revert the effects of the undo action

A toggle button which starts or stops the simulation mode.

- This state indicates that the ESD 4.10 is in simulation mode.
Clicking this button stops the simulation.

- This state indicates that the ESD 4.10 is out of simulation mode.
Users can drag/drop widgets or edit them safely.

To automatically restart the EVE emulator. Clicking this button will force the

simulated screens to be re-drawn.

To recompile the whole project’s source code using ESD built-in TinyCC
compiler. It is a mandatory procedure for simulation.

Select the hardware platform as source code building target

To select EVE module type

To set screen size

Select the building configuration when toolchain is invoked to build
To select flash chip type

Build the project files

Select toolchain to build

Upload Flash file to device and/or run executable file

Select executable mode
Table 3 - Toolbar & Description
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119 - IE:E&:SFI Eisxx Emulator hErar}'_\._'_B.Cl.E} b Emulator

ME&13AL-WHS0C ~ [Cmea1zau-wt >~ B wvea (B00x =

AppScreen, 1 App.main 7 r IMMI0OEVLE
MMIDDEV2A
rAMS00
MMI00DEY -Lite
MMISOEV -Lite

FT4222

Figure 18 - MCU Type is not applicable to selected platform

The red exclamation mark in the image above means those MCU types are not applicable
to the currently selected platform.

Product Page 28
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

)

& Bridgetek

.0
* BRIDGING TECHNOLOGY

BRT_AN_029 EVE Screen Designer 4.10 User Guide
Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Project Explorer ‘

The Project Explorer window organizes all the files used in the project in a tree view. It
also lists out all the resources used by each file. Project explorer allows users to navigate

each page of the project.

Project

wP =
FT_Esd_Framework.e
Nidget

= <

App.main
- -
= Connections

b '_! MNodes
4 - User Interface

B AppScreen.page
Actars

= Connections

‘B DefaultTheme.theme
B FirstPage.page
rs

-t

Connections

Figure 19 - Project Explorer window

In case of many items existing in a project, user can use filter textbox in order to get a
sort list of items. Text that matches the filter is highlighted. Regular expressions are

supported.

Project
arc|panel

= B MewProject esd

/| _Esd_Scroll
| Ft_Esd_Touch
-~ @ FirstPage.page

j n
BN eso B Stider
Figure 20 - Project Explorer Filter
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Screen Layout Editor \

The Screen Layout Editor displays the rendering output of EVE and allows users to edit C
source code. The page/widget/main files can be opened and edited in this editor.

MainPage.c 7

ESD

YA elehlati
Pl ]

Flian2

[Ziiimn &

/{ User state for our dynamic widget

{
Ft_E=d Pust ton Button:
MainPage 9
Te

} ButtonS

[/ Text callback
*Button Text (ButtonState *context)

Figure 22 - Screen Layout Editor - MainPage.c (C Source Code)

It shares one view port with the logic node editor. Users can adjust the size of the screen
layout editor by dragging the splitter handle.

Users can drag and drop the widgets from the library browser to form the layout when
simulation mode is "off”. For the other kinds of logic nodes, if the EVE rendering process
is not defined, screen layout editor does not allow them to be dropped in.
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App.main 7 AppScreen.page

Close tab 160 180 200 220
I I

| |
Close other tabs

Close all tabs

Figure 23 - Context menu on Tab bar

Users can right click on tab bar to active a context menu. Those menu items are
described in table below.

Menu Description

Close tab Close the current tab

Close other tabs Close all tabs except the current tab
Close all tabs Close all tabs that were opened

Logic Node Editor \

The Logic Note Editor allows users to layout logic nodes and to establish connections to
create logic maps. Users can drag and drop a logic node from the Library Browser
component to the Logic Note Editor in order to create connections.

Fixed Position Set Variable ESD Label 4
Pointer Se ] Pointer
Target Theme
Font

¥

Width Set Variable 3

Height = O

f Target

Condition Set Variable 4

O
Target

Set Variable 2 Pointer

Theme

)
Font

Target

Figure 24 - Logic Node Editor
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Library Browser \

The Library Browser allows the storing of all the available logic nodes and resources in
ESD 4.10 that includes both built-in and user-defined ones. Users can view these logic
nodes by category and select one for their project.

Library

ESD Layouts
ESD Render Functions
ESD Theme
ESD Utilities
5D Widgets
Lagic Flow

Legic Interface
User Actors
Uszer Functions
User Layouts
User Logic
User Pages

User Resources

&
2|
A
A
a
a
2|
2|

User Widgets

Figure 25 - Library Browser

The following table provides the ESD library name and its description -

Library Name Description

ESD Layouts ESD built-in layout widgets and relevant utilities

ESD Render Functions ESD built-in Render functions

ESD Theme ESD built-in basic theme manipulation functions

ESD Utilities ESD built-in utilities

ESD Widgets ESD built-in widgets

Logic Flow ESD built-in logic node for control flow

Logic Interface ESD built-in logic node for interface

User Actors User defined actor logic node. It is empty by default.

User Functions User defined functions. It is empty by default.

User Layouts User defined layouts. It is empty by default.

User Logic User defined logics. It is empty by default.

User Pages Pages added by user. It is empty by default if no page is created.

User Resources Resources added by users (For example: bitmap). It is empty by
default.

User Widgets Widgets created and added by users. It is empty by default.

Table 4 - ESD 4.10 Libraries

Error List ‘
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The Error List is a dock window which shows the message output from ESD 4.10, while
saving and recompiling the project files. Any error message displayed in this window
indicates that the generated source code for the current project is unable to be executed
successfully. Users need to double check the logic defined in /logic node editor or the
user-defined source code in the project.

Error List

Clear Collapse

* Connection target Conditi
* Duplicate data input to if

wamples [Basic/

Inspector  Error List

Figure 26 - Error List Window

The Output component is a docked window which shows the message output from the
EVE emulator and Toolchain.

Cutput

Simulation
Build

To check a message from the EVE emulator, click “Simulation” from the drop down list.
To check a message from the EVE Toolchain while building generated source code, click
“Build” from the drop down list. This window is automatically updated during simulation
or building.

Property Editor \

The Property Editor allows user to edit the properties of selected logic nodes. The sample
screenshot given below shows the property editor of an ESD Push button.
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Properties

Property Value
({ESD Push Button)

ESD Push Button
Static

0.00

¥ True

263

118

120

36
Ft_Esd_Theme_GetC...
27

Button

Primary v True

Figure 28 - Property Editor (ESD Push Button)

The Status bar is found at the bottom of the user interface. It primarily displays the
current status of any of process or job that is being handled by the application. For
example, if the user is performing a C compilation, then the compilation status of the

generated C code is displayed.

Simulation status
(whether in progress or

not) &

e/ \eey

The percentage of RAM_G
memory used by the current page

BITMAP_HAMDLE: % RAM_G: % +* C compilation * Render

e p—

The percentage of bitmap The compilation status of the
handles used by the current generated “C” code. Project
page cannot be simulated if the

compilation fails.

Figure 29 - Status bar

Application Project Structure \
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An Application consists of one or more pages. Each page in turn may contain one or
more widgets. Widgets and pages are connected via connection lines so that the screen
logic is defined.

The application model follows a strict hierarchical structure where all the pages are
owned and managed by the application, and all the widgets are owned by their
respective pages. The visibility and memory lifetime of the widgets are thus managed on
a page-by-page basis.

By design, all widgets and pages are generated to be entirely modular and self-sufficient.
Any interaction between the widgets and pages is therefore required to be routed
through the hierarchical chain. (Only node connections exist between the directly
connected nodes in the hierarchy.)

[ App.main ]

l D Application

Page

S | Switch Page

Widget

AppScreen.Page

S
|

Page Page Page

Figure 30 - Application Project Structure

File Name Description

*.esd Project file - This XML file describes what files are included in this project. This file
is unique for the whole project.

*.main Logic file - This XML file describes the application level logic. By default, it is
named as “App.main” and is unique project wide.

*.page Page Node Definition file - This XML file describes what widgets are contained and

connected in each page. By default: “"AppScreen.Page” is added, where a switch
page may be included for control on page transition. A page can contain other
pages, but switch page is required for page transition control.

*.widget Widget Node Definition file. This XML file describes a widget detail.
A widget can contain other nodes, which may include widget node, actor node and

logic node.
*.actor Actor Node Definition file. This XML file describes the actor node details.
*.logic Logic Object Definition file. This XML file describes the logic node details.
*.theme Application Theme Definition file. This XML file describes the theme detail.
*.h C language source header file
*.c C language source body file
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*.png, Image resource files
*.jpg,
*.jpeg

Note: The file nhames listed above shall NOT be conflicting with the C standard library
function as well as windows header files. Here are some examples: fopen, windows,
winbase, math, printf, realloc. ESD 4.10 simulation process may give errors and fail, if
user gives the file name of their widgets, logics, images, or any resources with these
reserved names. Therefore, ESD 4.10 enforces the ‘Usr_’ prefix to all the new/renamed
widgets, pages, functions, actors, as well as source file, theme, logic source file etc, in
order to ensure that the simulation process succeeds without error.

Application Workflow \

The workflow given below illustrates how to create an EVE based GUI application using
ESD 4.10.

Screen Logic Node Source JIT EVE Emulator
Layout Editor Editor

O la 1b

A 4 A 4

A{Design Layout] —»[Design Logic]

Generator Compiler

2 » Generate C é» Build

4b 4c Y

Simulate

Export R i

Figure 31 - Application Workflow

The 5 main modules that comprise the application workflow are the Screen Layout
Editor, Logic Node Editor, Source Generator, JIT Compiler and EVE Emulator. Among
these, Source Generator, JIT Compiler and EVE Emulator are the back-end modules
which have no Ul exposed to end user. The compiler is a JIT style C compiler, i.e. TinyCC
compiler, which compiles and links the generated code into executable. The executable is
invoked by the emulator module for simulation.

The application workflow starts by design layout (1a) or design logic (1b); Upon user
saving the changes, it will trigger C code generation (2), then the compiler will try to
build the generated c code; if any error encountered during building, then user needs to
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continue on design layout (4b) or design logic (4c); or if no error found, then the
emulator will start simulating (4a) the project. Users will be able to upload (5b) the
binary to the EVE chips or export (5c) the project as eclipse C project.

Design Layout using Layout Editor

Users need to determine how many pages are included in the project and what widgets
are to be contained in each page. After a page is created, users can drag and drop the
widgets to design the appearance of the page in the screen layout editor. This process
determines how many screens are shown in the project and how they look like together.

Custom Widget

ESD 4.10 provides a set of built-in widgets for users to construct screen layouts.
Additionally, if the built-in widgets does not meet the design requirement, users may
define and design custom widgets.

Add Bitmap Resource

To display a bitmap on the page, users need to add a bitmap resource into the project.
The following steps will provide guidance on how to add a bitmap resource:
a. Create a New PrOJeCt (File > New File r\]:jt Build Tools View Help File N:jt Build Tools View Help :
Project) or open an existing Project ¥ B Add
(File > Open Project). = Save B sae
Close
= Save All

Mew Project

b. Click File » Add from the menu. File Edit Build_Taols View
New
B Add b
J B Save
Close

o Save All

c. Browse and select the image file(s) from the file explorer window.
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Organize « MNew folder

Bl Desktop - Mame Date modified Type

& Downloads o ]
. Advanced 23/1/2017 3:37 PM File folder

| Basic 23/1/2017 3:37 PM File folder
. Intermediate 23/1/2017 3:37 PM File folder

=] Recent Places

4 Libraries
@ Documents
J? Music
[ Pictures
=l Subversion

EE videos

All Files (*.%)
. Computer Legic (*logic)
& Local Disk (C: Actor (*.actor)
i Local Disk (C) Widget (*.widget)
a Recovery (D:) Page (*.page)
== HP_TOOLS (E3) Application Logic (*.main)
C file (*.
L Websites (\iglaappsl) (W:) rce . ¢ )
S general (\\glafsl\Data) (X:)
S# L Subramanian (\\SMNGFSIAL
=8 neneral Mennfel\Natal (71 7

File name: ~ | AllFiles (+7)

o

Users can configure a bitmap resource via the Property Editor. Select the image file
from the project browser and check the Property Editor.

Properties
Property Value
(Resource File Proxy)
File Name Resources/LosAngeles....
Name Bitmap
Category
ARGB1555
v True
i 0
CellNames 0
Persistent
Width

Flgure 32 - Property Editor
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Property Value/Description
File Name Name of the image file
Name Resource Type Name. In this case, the selected resource type is Bitmap.
Category Category of the selected object
Format Image Format - The target format of bitmap can be -

L1/L2/L4/L8

RGB332/RGB565

ARGB1555/ARGB2/ARGB4

PALETTED4444/PALETTED565/PALETTEDS8

DXT1

JPEG (Decoded into RGB565 format only)
PNG (Decoded into RGB565 format only)
COMPRESSED_RGBA_ASTC_4x4_KHR
COMPRESSED_RGBA_ASTC_5x4_KHR
COMPRESSED_RGBA_ASTC_5x5_KHR
COMPRESSED_RGBA_ASTC_6x5_KHR
COMPRESSED_RGBA_ASTC_6x6_KHR
COMPRESSED_RGBA_ASTC_8x5_KHR
COMPRESSED_RGBA_ASTC_8x6_KHR
COMPRESSED_RGBA_ASTC_8x8_KHR
COMPRESSED_RGBA_ASTC_10x5_KHR
COMPRESSED_RGBA_ASTC_10x6_KHR
COMPRESSED_RGBA_ASTC_10x8_KHR
COMPRESSED_RGBA_ASTC_10x10_KHR
COMPRESSED_RGBA_ASTC_12x10_KHR
COMPRESSED_RGBA_ASTC_12x12_KHR

Compressed | Set bitmap compression on/off

CellHeight The pixel number of one cell. For example, if the bitmap width is 240 and height
is 240, then it can be defined as two cells with “CellHeight” - 120 or four cells with
“CellHeight” - 60. Cell Height default at 0 which means there will be only one cell
no matter how large the bitmap it is.

CellNames This field will enable system to create a list of n number of user defined cell
names instead system generated which is suffixed with *_x".

CellHeight MochiRiceCakeDXT1_Cell2

* CellMames MochiRiceCakeDXT1_Celld

(0] MochiRiceCakeDXT1_CellA
[1]

MochiRiceCakeDXT1_CellC
MochiRiceCakeDXT1_End

[2]

[3] Celld

[4] End
Persistent Keeps the memory persistent even if the bitmap is not displayed when it is true.
Width The width of bitmap image in pixels
Height The height of bitmap image in pixels

Table 5 - Bitmap Resource Properties

Design Screen Logic using Logic Node Editor

Users can define the dynamic behaviour of an application in this stage. The Logic Node
Editor employs the innovative visual programming idea to help users define logic flows
without coding.
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During this stage, users can decide the behaviour mode of both inner-page and inter-
pages. For inner-page behaviour, users can connect the widgets on the page via the
logic node editor adding more logic nodes from the library browser, if necessary.

Inter-page logic behaviour is captured in the application logic, which is normally named
as “AppScreen.page”. Users are required to drag and drop the predefined pages into the
logic node editor and connect these pages via the logic interface. This will define the
inter-pages behaviour like screen logic.

To validate the behaviour of the screen logic, users may need to simulate the project on
the PC before compiling and downloading the generated C code into the target device.
When application logic (AppScreen.page or App.main) is selected, users can simulate the
whole project by clicking [Simulation] button on the toolbar. When the application is in
simulation mode, users cannot drag and drop the widgets into the layout editor. The PC
mouse will act as a touch stylus on the touch panel to interact with the application
directly.

To validate the behaviour of single page, users need select the page file and open it with
logic node editor before clicking the [Simulation] button on the toolbar. Similarly, users
can simulate the behaviour of other logic node, such as widget, actor by opening it with
logic node editor and clicking [Simulation] button on the toolbar.

Before performing a simulation, it is strongly recommended to save the current project
by clicking [Save all] button. Once the simulation is completed, ensure to switch off the
simulation mode by clicking the [Simulation] button again.

Simulation State Description
- ON State - Indicates that the simulation is in progress. Clicking on it will
switch off the simulation. In this state, users will not be able to edit the

page or project.
OFF State - Indicates that currently simulation is not in progress. Clicking
on it will switch on the simulation.

Target selection \

ESD 4.10 provides support for the following built-in build targets -

ME817EV-WH10C
ME817EV-WH70C

1. ME812A WH50R
2. ME810A HV35R
3. ME813AU WH50C
4. VM816CU50A

5. VM816C50A

6.

7.

These build targets typically come with standard configuration which the user can modify
within certain limits as per the requirement.

ESD 4.10 also provides a mechanism to create new custom targets for new ESD projects.
For example, if the user wants to create a new build target "“pc_BT815eMU_wvGA” with PC
as Host platform, BT815 as EVE platform, Screen Resolution as WVGA (800 X 480) and
Flash set to 16MB MX25L16. Refer to the screenshots given below -
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‘* Mew Project

Target Platforms:

Mew Target

TE15EMU_WVGA

wild target platform

Figure 34 : Configure custom target

The newly created target can then be set via build target. Refer to the screenshot given
below:

Product Page

41
Document Feedback

Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

)

\/
o { Brldgetek BRT_AN_029 EVE Screen Designer 4.10 User Guide
(4

. .
A BRIDGING TECHNOLOGY Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

[ MEB17EV -~ [Ewxca (1280x800) ~ [ElFT4222 ~ | @ w25Q128

' PC_BTS1SEMU_WVGA App.main Usr_Page.page ™'
B0 120 160 200 240 280 320 360 400 440 480 520 560
Figure 35 : Select custom build target

Build & Upload

FT4222 x86Release = £  RunExecutsble

Figure 36 - Build & Upload
“"Build Executable” button builds a project.

“Build and Upload to Hardware” button for a FT90X toolchain will invoke the compiler
and programmer, so that the current project can be build and uploaded into the target
hardware. If user selects x64 toolchain, this button will build and generate an ‘.exe’
application which can be run on a PC as host environment.

In ESD 4.10, new build targets "ME817-WH10C"” and “"ME817-WH70C"” have been added
to the build target list. The respective output files generated by “Build Executable” for
different build configuration and host platforms are shown in Table 6.

. Host Output
Build Targets Platform | files
FT90x *.bin;
toolchain | *.elf
ME812A WH50R X64 .
toolchain | exe
(FT4222, )
MPSSE)
FT90x *.bin;
toolchain | *.elf
ME810A HV35R X64 .
toolchain | , exe
(FT4222, :
MPSSE)
FT90x *.bin;
toolchain | *.elf
ME813AU WH50C X64
toolchain | , exe
(FT4222, )
MPSSE)
FT90x *.bin;
toolchain | *.elf
VM816CU50A X64
toolchain |
.exe
(FT4222,
MPSSE)
FT90x *.bin;
toolchain | *.elf
VM816C50A X64
toolchain | ,
.exe
(FT4222,
MPSSE)
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FT90x *.bin;
toolchain | *.elf
ME817EV-WH10C X64 .
toolchain |, | o
(FT4222, '
MPSSE)
FT90x *.bin;
toolchain | *.elf
ME817EV-WH70C X64 .
toolchain | exe
(FT4222, !
MPSSE)

Table 6 - Output files for different Build Configuration & Host Platforms

Upon completing the screen design, it's time to move the project to the next phase of
the workflow - export project. There are two ways of exporting project. They are
“Export as Eclipse Project” and “"Export as MSVC Project”. This function is used to
prepare all the necessary files for the MCU tool chain so that users can make further
enhancements such as connecting sensors or external hardware to a full HMI solution.

On exporting, ESD (4.10) copies the generated “C” source code, the necessary bitmap
resources and the ESD 4.10 application framework code into a user defined folder. In
ESD, all the generated files are named as “*_generated.c”. For eclipse export projects,
“.cproject” and “.project” files are generated so that the users can open the project in
FT90X eclipse IDE2. For MSVC export projects, “Project” folder is generated containing
the MSVC compatible project. Table 7 gives more information on the Build Targets, Host
platform and the corresponding export projects that can be created.

Build Target Host Platform Export Project
Emulator, FT4222, MPSSE | MSVC Project
MM900EV1A,
MM900OEV1B,

ME812A WH50R MMOO0OEV2A, Eclipse Project
MM900EV3A,

MMO0O0EV-Lite
Emulator, FT4222, MPSSE | MSVC Project
MM900EV1A,
MM900EV1B,
MM900EV2A, Eclipse Project
MM900EV3A,

MM900EV-Lite
Emulator, FT4222, MPSSE | MSVC Project
MM900EV1A,
MM900EV1B,
MM900EV2A, Eclipse Project
MM900EV3A,

MM90O0EV-Lite
Emulator, FT4222, MPSSE | MSVC Project

ME810A HV35R

ME813AU WH50C

MMO0OEV1A,
VM816CU50A MM900EV1B, Eclipse Proiect
MM9OOEV2A, P ]
MM900EV3A,
2 http://brtchip.com/ft9xx-toolchain/
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MM900EV-Lite
Emulator, FT4222, MPSSE | Eclipse Project
MM900EV1A,
MM900EV1B,
MM900EV2A, MSVC Project
MM900EV3A,

MM900EV-Lite
Emulator, FT4222, MPSSE | Eclipse Project
MM900EV1A,
MM900EV1B,
MM900EV2A, MSVC Project
MM900EV3A,

MM900EV-Lite
Emulator, FT4222, MPSSE | Eclipse Project
MM900EV1A,
MM900EV1B,
MM900EV2A, MSVC Project
MM900EV3A,

MM900EV-Lite
Table 7 - Build Targets, Host platform and the corresponding export projects

Exported Folder Structure \

Table 8 provides the list of folders and files that are created upon exporting the project:

VM816C50A

ME817EV-WH10C

ME817EV-WH70C

Folder / Files Description
(Common export files)
Esd_Core Contains the application core files.
It is recommended not to make any changes to this folder/
files
FT_Esd_Framework Contains the application framework files.
It is recommended not to make any changes to this folder/
files
FT_Esd_Widgets Contains the widget files
It is recommended not to make any changes to this folder/
files
FT_Esd_Hal Contains the hardware abstraction layer files. These files may
be changed to support a different MCU.
Data Contains the converted bitmap resource data and the flash data
which is used by the current project
$(ProjectName) Contains the application specific source code
(Eclipse export files)
.cproject (for Eclipse export) Eclipse project file
.project (for Eclipse export) Eclipse project file
ThirdPartyLib Contains third party files such fat filesystem library handler files

(MSVC export files)
Project/$(ProjectName)_MSVC/ | MSVC project solution file
$(ProjectName)_MSVC.sIn

Project/$(ProjectName)_MSVC/ @ MSVC visual studio C++ project file
$(ProjectName)_MSVC
/$(ProjectName)_MSVC.vcxproj

Table 8 - List of Folder & File created upon exporting project
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Bitmap Resource

The bitmap resources used in an ESD 4.10 project can be saved in a SD card or to flash
based on the selection of flash flag configuration in the ESD 4.10.

SD card

If Bitmap resources meant for SD card are used in a project, it is converted to *.astc (for
ASTC file format)/*.raw(for other file formats) or *.bin file format (if compressed flag is
selected). Users are required to download the converted bitmap resource into an SD card
root directory and insert the SD card into the hardware module.

The converted bitmap resource is located at:
$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE
engine command CMD_INFLATE.

As per the Hardware Platform requirements, the SD card must be formatted as a FAT32
file system.

Flash

If bitmap resources meant for flash are used in a project, it is converted to a Flash.bin
file. Users are required to download the converted bitmap resource into flash memory of
the hardware module.

The converted bitmap resource is located at:

$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE
engine command CMD_INFLATE.

Layout Editor

The Layout Editor allows users to preview a single page as well as the whole project.
ESD 4.10 employs the EVE emulator to render an EVE display onto the layout editor. It
provides users, the interface to view the result of the screen design and its logic.

The following file types are displayed in ESD layout editor:

e Application logic file - generally with “.main” extension
e Page file - generally with “.page” extension

Page File

Page stands for a single screen which will be rendered. One application consists of at
least one page. Page may have its own life cycle and manages all the widgets on it. Only
widgets can be dragged and dropped into pages at Page layout editor. However, all the
nodes from a library can be dragged and dropped into the logic node editor.
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“Active” Property

The "“Active” property is a boolean value to control the page, and is created or released
while the application is updating the pages. By default, the “Active” property is True. The
page is created and shown, unless “Switch” end is connected.

Switch Page

Users can define multiple pages within the project. "Switch Page” ESD layout should add
to manage the pages. User can drag and drop the pages into this switch page from
project browser. The picture below displays how the logic editor view looks like for the

switch page logic.

AlarmClock.esd

B
B
B

AlarmManager.actor
ﬂ AlarmManager.c

B AlarmPage.c

Ej] AlarmPage.page

Switch Page
SystemPage
omMenu

kPage.page
B HalifPulselogic
B setPagec
B setPage.page

Figure 37 - Switch Page
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App.main AlarmPage.c AppScreen.page® 7

SystemPaage

Painter

Height
TimeManager
AlarmManager

BottomMenu

Faointer

ClockPage

Pointer

O
O

Height
SetPage

O Activate
(W]s!
TimeManager
Active
X
¥
Width
Height

Figure 38 - Sample Switch Page UI

Page Persistence \

To allow a page to remain in memory with its current state even when it is made
inactive, set the allocation mode to “Lazy Persistent” or “Static” from the application
logic in the page's Properties. This feature can help users to reserve the information of a
page even when it is not visible.

File Edit Build Tools

WH50R ~ FT90xRelease ~ FT200 One-iire

App.main 7 Chid 4 »

Value

-

r

Height
! Output &

Figure 39 - Properties Editor — Page Allocation

The page allocation modes supported in ESD 4.10 are listed in the table given below:

Allocation Mode Description

Static Page is always persistent in memory after application starts

Lazy Page is created when it is in “active” state and destroyed when it is
inactive

Lazy Persistent Page is created when it is in “active” state but persistent in memory when

it is “inactive” until application is closed.
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User Defined Function for Page File

Users can write their own code to handle the “Pushed” signal of the "ESD Push Button”
widget. Users are required to select the “ESD Push Button” widget in the logic node
editor and double click it. A function will be generated to replace the user defined

function.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed(MainPage *context)

{

// Users can write their code here

}

The code can be located at $(PageFileName).c file.

MainPage.page® ™ App.main MainPage.c **

ESD METHOD(MainPage ESD ushed, C = MainPage)
MainPage ESD

/..
printf{"This

Figure 40 - Sample Source File

Zoom I Out

The visual area of the screen layout editor can be zoomed when the current file is a page
file, i.e., "“.page” file. The mouse wheel button provides zoom-in and zoom-out
functionality, allowing users to view more details about the screen design. Refer to the

sample picture given below:

4?0 4;0 4T’l0 4ISD 4§D spo SIZIJ 5‘40 S:E-G 5?!0 -

Figure 41 - Zoom In & Out
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To view the application logic file (*.main) file, double click the file within the project
explorer. The screen layout editor will show the first page defined in the logic node
editor. To view how the application logic is defined, click the “Simulation” button and
check it in the screen layout editor.

File Edit Build Tools View Help

MES12A WHS0R ~ FT90x R e FT900 One-Wire ~

App.main MainPage.c *

ESD

ADD Scre

creen.page Y

2 |

B ec Width

g :aﬂatlr:ragapage YAl NNE Height
Ftest.theme

| Output S ile Name App.main

® 0 Errors A rmings o 0 Mess:

ctor Error List
BITMAP_HANDLE: 3 RAM_DL: WAM_G: +* C compilation | 100% ® Render

Figure 42 - Main File

Logic File \

The logic file contains certain logic that is used to encapsulate the user defined logic. It
works similar to a C function. A logic file does not render any user interface.

Ft_Esd_IntCounts

Set Variable

+1Plus

EEEE]L T

Set Variable

Signaled @}

[-1 Minus

Rl Tl

jaf@aw - -~ Qafa@--ridada@- - - Doao=n@a@E5

Figure 43 - Sample Logic File
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The screen layout editor provides a simple C editor when users double click a “.c” file in
the project browser. Note that it is not a full-fledged C editor and many features may be
implemented in the future.

File Edit Build Tools View Help

o C - ) ™ i MES12A WHSOR FT900 One-Wire

Simple C
Editor

ESD FUNCTION tSat VD DisplayName =
ESD PARAMETER r

ESD PARAMETER (v0,

ESD PARAMETER (x1,

ESD PARAMETER (v1,

ESD PARBMETER(r,

Figure 44 - C File / C Editor

~ '~ To effect the changes made, ensure that all the changes are saved to the project by
clicking “File = Save All” from the menu or from the toolbar.

Logic Note Editor

Using the Logic Node Editor (LNE), users compose screen logic by connecting logic
nodes. The Logic Note Editor is designed to open the following file formats:

Application logic file , *.main file
Screen logic file, *.page file
Widget file, *.widget

Actor file, *.actor

User defined logic file, *.logic file

Basic Logic Node ‘

ESD 4.10 has some built-in predefined basic logic nodes. These basic logic nodes
provide basic control flow and logic interfaces as well as basic functions. A typical basic
logic node is represented in the logic node editor as below, the name of which is shown
in white.

Ft_Esd_DI_COLOR_ARGB

|

Color

Figure 45 - Logic Node Editor - Basic Logic Node

Within the library browser, the basic logic nodes are located at "Logic Flow”, "Logic
Interface”, "ESD Utilities” and "EVE Render Functions”.
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File Edit Build Tools View Help

App.main

Bl AppScreen.page
B MainPage page

Figure 46 - Library Browser - Basic Logic Nodes

—p

!} MEB12AWHSOR ~  FT90x Release

FT200 One-Wire ~

Ft_Esd_ColorPicks

PARAMETER (2
ARBMETER (3

ESD PAREMETER(r,

A Composite Logic Node is made up by connecting multiple basic logic nodes. A typical
composite logic node is defined in a standalone document in XML format and is shown in
the logic node. Refer to the picture given below -

ESD Push Button
Active
Down [
up [
Pushed []
Theme
X
Y
Width
Height
Font
Text
Primary

Figure 47 - Composite Logic Node

The following are the different types of composite logic nodes defined in ESD 4.10:

Page Node
Widget Node
Layout Widget
Actor Node
Logic Object
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Page Node

When users create a single page, it is represented by a logic node under the “User Page”
category in the library browser. Users can connect one page node to another within the
logic node editor. It has its own property and defined output.

AppScreen

Pointer

O
O

Width
Height

Figure 48 - Composite Logic Node - Page Node

Widget Node

The Widget Node is one type of logic node which has visual appearance and is able to
handle user input. It has the built-in Start, Update, Idle, Render and End slots.

For more information on built-in slots, please refer to Built-in Slot.

Within the logic node editor, the widget name is highlighted with the colour title as
shown in the sample picture below -

* App.main
120 16

Theme
Alpha
Hours
Minutes
Seconds
Miiiseconds
Interactive
Active

X

Y

Width
Height
> AutoResize

® okrrors | | Aow

wpector | Error List

Figure 49 - Logic Node Editor - Widget Node

The highlighted sections provide information on adding user widgets; the position and
size properties; rendering the widget and widget theme.

Product Page 52
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

Y .
< Brldgetek BRT_AN_029 EVE Screen Designer 4.10 User Guide
0.‘

*

BRIDGING TECHNOLOGY Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Adding User Widgets

. File Edit Build Tools WView Help
A User Widget, also called as custom New » B Logic
widget is a reusable user interface B Add —
element created by a user. To create J - H X E!‘u';f'd- "
a widget, from the menu, click and |lem 998
select “File > New > Widget”. Close BN Page
= Save All “& Theme

. Cource Files
Mew Project B Source Files

Open Project m Logic Source Files

In order to make use of these slots, users need to drag the slots from the library
browser and drop them into the logic node editor. By renaming it to the slot defined
above, users can connect widget control flow to application control flow.

Position & Size Properties

As a user interface element, widgets have at least position and size properties so that
users can control them using a visible handle. Position property is defined by an “Input”
node with “ft_int16_t" type named as “X” or “Y”. Size property is defined by an “Input”
node with “ft_int16_t" type named as “Width” or “Height”. Figure 50 provides a sample
of the “X” property.

Properties

Property Value
Input)
Name X
Display Name

Comment

Type
Edit Role

Min

Max
Single Step
Default

Figure 50 - User Widget - Position & Size Properties

Rendering a widget

Rendering of a widget may be implemented fully in the logic editor, or directly in the
code using the logic editor to glue together the code with the generated structures. To
create the render function, simply add a Slot from the Logic Interface category of the
library browser, name it “Render” and double click to create the user method for
handling the rendering. The widget is expected to restore any graphics state it changes,
with the exception of the state values specified below.

Preferably use the Ft_Esd_DI_ utility functions for display list drawing when available.
Several state parameters which may be expected to be changed often to the same value
implement de-duplication here to shorten the display list. The de-duplicated values
are: Palette source, Color RGB, Color A, Handle, Cell, and Vertex Format. These graphic
state values are not required to be restored to their original values when the Ft_Esd_DI_
functions are used. These values should be expected to be any undefined value at the
start of the Rendering function. Access the value of the X input property as given below:

int x = context->X(context->Owner) ;
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This calls the get () function assigned by the parent to the X property, passing the
owner’s context to the function to handle it there.

Theme

Widgets should provide property input to override the default application theme. An
input property with type Ft_Esd _Theme * should be added by dragging one input node
from the “Logic Interface” category of the library browser. Colours from the theme may
be accessed from the logic editor using the utility functions under the ESD Theme
category, or from the user code as given below:

Ft Esd Theme *theme = context->Theme (context->Owner)
if (theme == NULL) theme = Ft Esd Theme GetCurrent ()
ft rgb32 t primaryColor = theme->PrimaryColor;

r
r

Touch Input

In order to handle the touch input, add a Touch Tag node from "ESD Utilities” category
of the library browser to the logic editor, and either handle the signals or access its state
through the Touch Tag interface. Users need to make use of the “Tag” value provided
by the “Touch Tag” node during the Render function, and restore the “Tag” to value 0
after the relevant portion of the rendering.

To handle any of the signals from Touch Tag in user code, simply create an
ESD_METHOD style function in the same format as the Render user code function, and it
will be available from the User Functions category in the library to drag into the logic
editor and connect to any of the signals from the Touch Tag node.

Layout Type Widget

Layout widget is a layout container for widgets. Unlike widget nodes which have visual
appearance, a layout widget manages the layout specification for its child widgets.
Layout widgets are introduced since ESD 4.0. Figure 51 & Figure 52 displays the various
layout widgets supported in ESD 4.10.

Library

- B
[
-

Figure 51 - Layout Widgets
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App.main®

Fill Layout Fixed Positioning Linear Lavout Scroll Lavout

Pointer Pointer Pointer Pointer

¥
Width Width \ Width
Height Height Height

Stretch Switch Page

Pointer Pointer
Active

- ¥
Width Width
Height Height

RangeX
Weight

RangeY

Width

Height

Scroll.. hanged
Scroll.. hanged

Figure 52 - Layout Widgets

Actor Node ‘

Actor type is an extended type of logic hode which functions similar to the widget node,
but without the Render slot. Therefore, it has no visual appearance. When users create a
new actor node, it does not show in the layout editor. It has the built-in Start, Update,
Idle and End slots which are not available in a regular logic node. For more information
about built-in slots, please refer to Built-in Slot.

An Actor node is useful for implementing both continuous and background running
behaviours, such as animations, timers, and input data polling. The actor node name is
highlighted with the yellow colour within the logic node editor.

SlideBackward

Active
@ Play O
Value
Writer

Figure 53 - Actor Node

To create an actor, from the menu, click and select “File > New > Actor”.

File Edit Build Tools View Help
Mew b B Logic
B Actor
BN Widget
B Page
& Theme
B Source Files

Open Praject B Logic Source Files

~ =~ Refer to the example project “ActorAnimator.esd” under the “EVE Screen
Designer — Examples — Basic = ActorAnimators” folder for adding and using
actor node.
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Logic Object

A Logic Object is a basic logic block designed to express certain logic which has NO built-
in slot. Hence, it is not possible to invoke it through the built-in render slot or update
slot. However, it may have its own private or public property and output, signal and slot,
depending on the users’ implementation.

A logic object is generally used to simplify complex logic by splitting it into multiple
smaller and simpler logic objects. It is defined and saved in a “*.logic” file.

Within the logic node editor, the logic object name is highlighted with the grey colour.

Switch Bitmap Cell
Bitmap Cell

Cell

Figure 54 - Logic Object

To add a logic object, from the menu, click and select “File > New - Logic”.

Connections \

Connections are lines between two nodes. The connection line’s colour is determined by
the ends. The following table provides the different types of ends and their description.

Connection Line End Type Description

Event slots and signals are implemented as functions which only

take a pointer to the node context as a parameter. The node

context contains the state of the node as well as a pointer to the
parent node to signal back.
L . Data property input and output bindings are implemented as get-

Data property bindings functions which only take a pointer to the node context as a

/ / parameter and return a value. This means that these connections
are completely evaluated every time the property is read, and

consequently the property always reads as the latest value. A

buffer variable can be used to cache values if necessary. The

different colours denote the different data types.

Variable write The write interface is translated into a function pointer during the
code generation. Variables are plain variables, which can be
written using the Set Variable node. They may also be set through
the Writer interface which is implemented using a pointer to a set-
function.

Table 9 - Connection End Types

Event slots and Signals

In general, all of the input properties that can be connected can also be specified from
the property editor when they are constant values; this is sometimes referred to as the
“Default” value. In addition, it is possible to specify the Minimum and Maximum values
for the input bindings and variables.

Rendering Order ‘
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In the application logic file "App.main”, the pages added on MainPage
the logic node editor are to be represented with the symbols Pointer
shown in the sample picture. O Activate

O
O

When there are more than two pages, the order in which the
pages were created determines the rendering order.

Width
The following implicit rule of the logic node editor is worthy to Height
be noted, since this rule applies to all the logic nodes.

“"Depth Sort” is used to determine the rendering order of the logic nodes. The
greater the value of “"Depth Sort”, the later the logic node is rendered and higher
the layer in which it is shown. When logic nodes have the same “Depth Sort”
value, the logic node’s “X"/*Y” coordinate (within layout widget) determines the
rendering order. The page node with the lowest value of the “X”/"Y"” coordinate
is rendered first (as lower depth value).

[0 Switch
Active

ToggleMainPage

Figure 55 - Rendering Order Example

Logic Note Editor - User Interaction \

The Logic Node Editor enables Zoom-in and Zoom-out functionality. Users can make use
of the mouse wheel button to zoom in and zoom out.

“Panning” the logic node editor screen helps reveals the parts of the logic node editor
which could not have been fit in a single screen. Panning can be done by 2 ways:

(i) Press Alt Key + Left mouse button and move the mouse
(i) Press the middle mouse button and move the mouse.
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User can select multiple node items in the logic node editor by pressing Control key and
selecting the desired objects by left mouse button click. Single/multiple objects can thus
be moved if needed by moving the mouse while pressing the Left mouse button.

Avoid two connections connecting to the same port. Refer to the sample
picture given below.

Active
Theme
Font
Text

¥
Width
ight
Alignx
AlignY
Unary Operator

Value
Variable

DON’TS

Avoid endless dead loops caused by connecting the input and output of the
same object. It will cause an unexpected error. Refer to the sample
pictures given below.

Set Variable

Active
Theme
Font

Ternary Operator Test

= e - "
OO LR T e

Vaiue It Trus ¥

Value If False Width
Height

- Alignx

O AlignY

To effect the changes made to the logic note editor, ensure that all the changes
are saved to the project, by clicking “File — Save All” from the menu or toolbar.

In some cases, click the “Recompile” n button to recompile the source code
generated by ESD.
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Library Browser |

The Library Browser consists of the basic components
which are predefined and built in as part of ESD 4.10,
as well as user defined components and/or resources.
The components in the library include Theme, Primitive,
Widgets, Logic Flow and Logic Interface. Users can
select the appropriate components and drag them into
the logic node editor or layout editor.

]

ESD Layouts
ESD Render Functions
ESD Thermne

ll

1]

il

il

g
Lo gic Flow

Logic Interface
User Actors

A .-

The library view depends on the currently selected
node. The library browser will only show the contents
which applies to the currently opened node.

EE@@EE

Figure 56 - Library Browser

In the Library Browser, items can be filtered by entering the search text in the textbox.
Regular expression is supported. The matching text is highlighted as shown in the
sample picture given below -

Library

pal|gra

* [N ESD Render Functions
B Elements

| | Ft_Es.-:I_EIErner‘lts._.-:lier'lt_F'anEI

B Primitives

W ESD Multi Giadient
. ESD Multi dient (Rounded)

. ESD I-:Iir.':nt Rectangl ted Point)

N Eso
ESD Widgets

=

dient Rectangle (Integer)

Basics

B EsD li:ircular.dierlt

o .u:l ient Widget

B ESD Multi Bfdient (Rounded)
B EsD l,-'g on Widget

Figure 57 - Library Filter

The forthcoming sections provide information about the different components of the
library browser.
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ESD Layouts ‘

ESD 4.10 Layouts contains the collection of ESD 4.10
layout widgets and layout utilities functions.

Layout
Dynamic Switch Page

Fill Layout

Fixed Positioning
Linear Layout
Scroll Layout
Stretch

Switch Page
Scroll Switch Page

% ESD Layouts
B Advanced
B utilities
@ Dynamic Switch Page

il Fill Layout

#" Fixed Positioning
I Linear Layout

M Scroll Layout

ﬂ Stretch

ﬁ Switch Page

B Scroll Switch Page

Description

This Layout is used to achieve a fade-in/fade-out animation from one
page to another page

This layout is used to fill up the whole widget display region

This layout is for fixed coordinate layouts

This layout supports both horizontal and vertical layouts

Specific layout for scrollable panel

This layout supports both horizontal and vertical layouts

To manage page switching logic

This layout supports scroll between pages according to the swipe
direction.

There are also layout utilities and advanced layout features provided in ESD Layouts
collection. These sections are for advanced user only.

Layout utilities are a set of helping functions to ease the development of layout. Users
can build their own layout widget by making use of them. There are several items
defined for sorting widgets purpose.

Utilities

ESD 4.10 provides various Layout utility functions
while designing layouts.

c

tilities

Get Horizontal Align
Get Vertical Align
Detach

Get Global Height
Get Global Width
Get Global X

Get Global Y
Insert Above
Insert Below
Insert at Bottom
Insert at Top

Is Bottom

Is Top

Is Visible

Sort Higher
Sort Lower
Sort to Bettem
Sort to Top

Product Page
Document Feedback

60
Copyright © Bridgetek Pte Ltd


http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

)

3/
B { Brldgetek BRT_AN_029 EVE Screen Designer 4.10 User Guide
*

. .
A BRIDGING TECHNOLOGY Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Get Horizontal Align

The Get Horizontal Align utility is used to align the widget Get Horizontal Align
horizontally.

) align

The function can be called as shown below:

ESD FUNCTION (ESD ALIGN HORIZONTAL, Type = Esd AlignHorizontal, DisplayName
= "Get Horizontal Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN HORIZONTAL (align) (align & 3)

Get Vertical Align

The Get Vertical Align utility is used to align the widget Get Vertical Align

vertically.  align

The function can be called like below:

ESD FUNCTION (ESD ALIGN VERTICAL, Type = Esd AlignVertical, DisplayName =
"Get Vertical Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN VERTICAL (align) (align & 12)

Detach

The Detach utility is used to detach the widget from the Detach
current parent layout ] cal

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget Detach, DisplayName = "Detach", Category =
EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget Detach (Ft Esd Widget *context);

Get Global Height

The Get Global Height utility is used to get the global X co- Get Global Height
ordinate of widget. context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalHeight, Type = ft intl6 t, DisplayName
= "Get Global Height", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalHeight (context) (((Ft Esd Widget *)context)-
>GlobalHeight)
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Get Global Width

The Get Global Width utility is used to get the width of Get Global width
the widget. context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalWidth, Type = ft intl6_t, DisplayName =
"Get Global Width", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalWidth (context) (((Ft Esd Widget *)context)-
>GlobalWidth)

Get Global X

The Get Global X utility is used to get the global X co- Get Global X
ordinate of the widget. tant

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalX, Type = ft intl6 t, DisplayName =
"Get Global X", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget ¥*)

#define Ft Esd Widget GetGlobalX(context) (((Ft Esd Widget *)context)-
>GlobalX)

Get Global Y

The Get Global Y utility is used to get the global Y co- Get Global Y
ordinate of the widget. CRREEAE

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalY, Type = ft intlé t, DisplayName =
"Get Global Y", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalY (context) (((Ft Esd Widget *)context)-
>GlobalyY)

Insert Above

The Insert at Above utility is used to insert a widget RERS TRk
above the specified sibling widgets in the sibling widgets (= Cag ;

Widge
parent layout. Sibling
ESD FUNCTION (Ft Esd Widget InsertAbove, DisplayName = "Insert Above",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertAbove (Ft Esd Widget *context, Ft Esd Widget
*sibling) ;
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Insert Below

The Insert at Below utility is used to insert a widget ASEN Ao

below the specified sibling widgets in the sibling (Rl

widgets parent layout. Widget
Sibling

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBelow, DisplayName = "Insert Below",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBelow (Ft Esd Widget *context, Ft Esd Widget
*sibling) ;

Insert at Bottom

The Insert at Bottom utility is used to insert a widget ASEEEBEKIG D

in the bottom position of the specified parent layout. Ll call
Widget
Parent

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBottom, DisplayName = "Insert at Bottom",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBottom(Ft Esd Widget *context, Ft Esd Widget
*parent) ;

Insert at Top

The Insert at Top utility is used to insert a widget in Insert at Top
the top position of the specified parent layout. [ call

Widget
The function can be called like below: Parent
ESD FUNCTION (Ft Esd Widget InsertTop, DisplayName = "Insert at Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertTop (Ft Esd Widget *context, Ft Esd Widget *parent);

Is Bottom

The Is Bottom utility returns FT_TRUE if the widget is Is Bottom
the bottom widget within the current parent layout.

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsBottom, Type = ft bool t, DisplayName = "Is
Bottom", Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)

ft bool t Ft Esd Widget IsBottom(Ft Esd Widget *context);
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Is Top

This Is Top utility returns FT_TRUE if the widget is the
topmost widget within the current parent layout Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsTop, Type = ft bool t, DisplayName = "Is Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsTop (Ft Esd Widget *context);

Is Visible

The Is Visible utility is used to check if the widget is Is Visible

within the current screen scissor area.
context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsVisible, Type = ft bool + t, DisplayName = "Is
Visible", Category = EsdLayoutUtilities)

ESD PARAMETER (context, Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsVisible (Ft Esd Widget *context);

Sort Higher

The Sort Higher utility is used to sort the widget Sort Higher
above its current sibling within the current parent O cal

layout.
Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortHigher, DisplayName = "Sort Higher",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortHigher (Ft Esd Widget *context);

Sort Lower

The Sort Lower utility is used to sort the widget below
its current sibling within the current parent layout.

O call
The function can be called like below: Widget
ESD FUNCTION (Ft Esd Widget SortLower, DisplayName = "Sort Lower", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)

void Ft Esd Widget SortLower (Ft Esd Widget *context);
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Sort to Bottom

The Sort to Bottom utility is used to sort the widget to

Sort to Bottom

the bottom within the current parent layout. O call

The function can be called like below:

Widget

ESD FUNCTION (Ft Esd Widget SortToBottom, DisplayName = "Sort to Bottom",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortToBottom(Ft Esd Widget *context);

Sort to Top

The Sort to Top utility is used to sort the widget to the

top within the current parent layout. O call
Widget
The function can be called like below:
ESD FUNCTION (Ft Esd Widget SortToTop, DisplayName = "Sort to Top", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)

void Ft Esd Widget SortToTop (Ft Esd Widget *context);

Switch Page

The Switch Page is a special layout which focuses on page/widget transitions. By default,
there will be only one Switch Page layout in “AppScreen.Page” in every ESD project.
However, this is optional and the users can remove or change the switch page layout in
the project. Refer to the example project "EVE Screen Designer -> Examples > Basic
- MenuPage > MenuPage.esd > AppScreen.page” for a switch page demo.

Property Name
Pointer

Active

X

Y

Width

Height

Spinner

Scissor
AutoResize

Switch Page
Pointer

Width
Height
Spinner
Scissor
AutoResize

sitioning
Linear Layout
Scroll Layout
Stretch
Switch Par

Description
The pointer reference of the widget object
Enable or disable displaying this widget
x coordinate of the top-left of the widget, in pixels
Y coordinate of the top-left of the widget, in pixels
Widget width
Widget Height
Set true to show spinner/loading icon when switching page. This is useful
user indication when a page has heavy resource.
Set true, to trim off any content is drawn outside the layout region.
Set true, to enable auto resize for this layout.
Table 10 - Switch Page Layout Properties
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Switch Page Implementation

P == App.main
= AppScreen.page
1. Set page/widget into Switch Page ors
< nections
Unlike widgets, Switch Page cannot be dragged on Screen A e
Layout Editor or Logic Editor. In order to put a page under ' 3“} -
the control of the switch page layout, the user has to use - ﬁ:'tj 1 Pags
. . . . . i UserPage
Project Browser instead, drag the widget into the switch B Main Page
page layout. ‘B DefaultThemetheme

2. Page Resource

Properties

Property Value

Since ESD 4.0, a page resource allocation can be:
MName Static
e Static - always load at the start Allocation Lazy
e Lazy - allocate when it is active, and free it when it is Depth Sort Lazy Persistent
inactive. Active T
e Lazy persistent - allocate when it is first time active, L
and it will remain in system until reset.

When a new page is activated, its parent object, the
Switch Page will also mark the current page as inactive and free it from memory when it
has “Lazy” mode of allocation.

Dynamic Switch Page

The Dynamic Switch Page is a special layout which focuses on page/widget transitions.
The primary purpose of this widget is to achieve a fade-in/fade-out animation while
transiting from one page to another page. Like Switch Page widget, only one of the
children of Switch Page would be visible at any point of time. But unlike Switch Page
widget which abruptly changes the visibility between the transiting pages, Dynamic
Switch Page widget will fade-in and fade-out the new to-be-visible page and old not-to-
visible page.
Library
Dynamic Switch Page
Pointer
Active
X

Y

Width

Height
AutoResize
Animation D...

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

AutoResize Set true, to enable auto resize for this layout.

Animation Duration Sets the time within which the animation needs to be finished.

Table 11 - Dynamic Switch Page Layout Properties
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Dynamic Switch Page Implementation

= , -
b == App.main

1. Set page/widget into Dynamic Switch Page - iF‘F‘S”EE"-F‘EBE

Unlike widgets, Dynamic Switch Page cannot be dragged
on Screen Layout Editor or Logic Editor. In order to put a <
page under the control of the switch page layout, the user @ Dynamic Switch Page

has to use Project Browser instead, drag the widget into gfgg';page
ShowPage

the Dynamic switch page layout.

2. Page Resource
Value

Since ESD 4.0, a page resource allocation can be:

Static

Allocation Lazy

e Static - always load at the start Depth Sort _

e Lazy - allocate when it is active, and free it when it is Active Lazy Persistent
inactive. 0

e Lazy persistent - allocate when it is first time active, 0
and it will remain in system until reset. i

Height

When a new page is activated, its parent object, the Dynamic Switch Page will also mark
the current page as inactive and free it from memory when it has “Lazy” mode of
allocation.

Auto Switch Widget

The Auto Switch Widget is a s Auto Switch Widget
layout which focuses on rapid ] Pointer
transitions between its child T Active

widgets. The primary purpose X

of this widget is to rapidly ' Y

activate its child widget one @ Dynan Width

by one in the order of its - Height

depth. The rate of change is ) Animation F._.

set by the user. This can be
used to generate a gif like
animation effect. Like Switch S
Page Wldget and Dynamic ) Render Functions
Switch Page widget, only one - .
of its child is active at any given point of time. But unlike Switch Page and Dynamic
Switch Page, the transition between child widget is automatic and not triggered. Use
case of the widget can be found in Examples/Basic/AutoSwitchLayout.

ch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Animation Frequency Sets the rate of change of child widget activations

Table 12 - Auto Switch Page Layout Properties
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== App.main

Auto Switch Page Implementation

Screen.page

1. Set widgets into Dynamic Switch Page

Auto Switch widget can be dragged on Logic Editor. In order
to put a widget under the control of the switch page layout,
the user has to use Project Browser instead, drag the widget

into the Auto Switch Widget layout.
@ espcC
T ESDELa[;eI

2. Widget Rendering order
All child widgets are activated one by one and rendered in a sequence according to their

depth orders. Thus to rearrange the order of activation, user needs to update the depth
order of the children widgets.

Fixed Positioning

The Fixed Positioning is a layout widget which allows its child widgets to be fixed at
design time. By default, every page starts with one fixed positioning layout, such that all
widgets under the page are placed at design time. Fixed Positioning layout does not
update its child widget's dimensions on runtime. Users should get what they see on
design time, on runtime as well.

P o= App.main B ESD Layouts
» W AppScreen.page Advanced
“‘® DefaultThemetheme

B FirstPage.page

B Utilities
IN Fill Layout
7 Fined Positioning

-

B Actors ]
<= Connections I Linear Layout
“m MNodes B scroll Layout

* il Widgets 0 Sstretch
P ¢ Fixed Position i_‘||

Switch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 13 - Fixed Positioning Layout Properties

Fixed Positioning Implementation

I —
== App.main

B AppScreen.page
‘B DefaultTheme.theme
B FirstPage.page

L

)
1. Set page/widget into Fixed Positioning Layout .
Drag and drop a new widget into the Screen Layout Editor
will be the highest depth sort widget in the layout by
default. However, the depth sort values are configurable
by the users. If a widget is not in fixed positioning layout,
the Screen layout editor will not able to change it is
position as it desired. Always check on project browser as
picture on the right.

serWidget]
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2. Change Child Widgets’ depth sort

Changing the depth sort value of child widgets will affect their rendering sequence. This
functionality is same as in ESD 3.0.

Fill Layout

The Fill Layout is the base e _'I-a;":':'““; Fill Layout

layout for every B Advanced i
widget/page since in ESD - Eiﬂlif:i-mt R
4.10. A widget always = —

i i ; Fixed Positionine
comes with a Fill Layout in L= itioning

it. However, a fill layout in
a page has a fixed size
due to the screen size
defined from the
hardware. All widgets in the Fill Layout will auto resize to fit the whole layout area.

Linear La
Scroll Layout
Stretch
Switch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 14 - Fill Layout Properties

Fill Layout Implementation

1. Change Widget sequence

Widgets
~* I Fill Layout
@ ESD Clock
B ESD Image

The fill layout sequence is ordered in the sequence of widgets’
depth sort. Changing a particular widget to a higher depth sort
value, will increase the priority widget’s rendering. The
example below shows a clock widget and an image
widget under the same Fill Layout. Both widgets are
filling up the full “Fill Layout” area. However, by
setting the depth value of clock widget bigger than the
image widget’s depth sort, the clock widget will be
rendered on top of the image widget.

Linear Layout

The Linear Layout supports both horizontal and vertical alignment in ESD 4.10. All child
widgets will be distributed in the selected orientation. Users cannot change the sequence
of widgets in the linear layout from Screen Layout Designer in ESD 4.10. However,
changing their depth sort value from the property browser will change the sequence.
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Linear Lavout

Pointer

Width
Height

Margin
Spacing
* Orientation
> Align

Scroll Layout
Stretch
Switch Page

Property Name

> Overflow
Scissor
ChildClipping
AutoResize

Description

Pointer The pointer reference of the widget object
Active Enable or disable displaying this widget
X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width
Height Widget Height
Spacing Set the spacing gap between adjacent child widgets.
Orientation Set Linear Layout orientation. It supports:
e ESD_ORIENTATION_HORIZONTAL
e ESD_ORIENTATION_VERTICAL
Alignment Set the alignment setting for the child widgets in the layout
Overflow Set child widget overflow mode. It supports:
e ESD_OVERFLOW_ALLOW
e ESD_OVERFLOW_CLIP
e ESD_OVERFLOW_FILL
Scissor Set true to enable scissor to clip off overflow
ChildClipping Set the flags when child clipping should check. It supports:
e ESD_CLIP_RENDER
e ESD_CLIP_UPDATE
e ESD_CLIP_IDLE
AutoResize Set auto resize mode for this layout.

Table 15 - Linear Layout Properties

Linear Layout Implementation

1. Horizontal Layout

All child widgets of a |linear layout with its orientation are set to
“ESD_ORIENTATION_HORIZONTAL"”. They will be distributed horizontally with some
spacing in between adjacent widgets. The layout used as in the example here has
parameters:

Orientation = ESD_ORIENTATION_HORIZONTAL
Spacing = 4

Align = ESD_ALIGN_TOPFILL

Overflow = ESD_OVERFLOW_ALLOW
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2. Vertical Layout

All child widgets of a linear layout with its orientation set to
“ESD_ORIENTATION_VERTICAL". They will be distributed vertically
with some spacing in between adjacent widgets. The layout used as
in the example here has parameters:

Orientation = ESD_ORIENTATION_VERTICAL
Spacing = 4

Align = ESD_ALIGN_TOPFILL

Overflow = ESD_OVERFLOW_ALLOW

Widgets

* I Linear Layo

The  Stretch  Layout is B ESD Layouts Stretch
designed to work together ’ Advanced .
with the linear layout. In the 4 Utilities R
event some widgets need to B Fill Layout

have higher weightage in the = Fixed Positioning

layout, Stretch Layouts are
used.

Width
Height
Weight

Stretch
Switch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

Weight The weight factor when determine the stretch scale in the

selected orientation
Table 16 - Stretch Layout Properties
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Stretch Layout Implementation

1. Space Stretching

The example here demonstrates how to stretch unused space horizontally. A stretch
layout has been added into the Linear Layout. The weight factor used here is 1.

= - Widgets
* I Linear Layout
Y Stretch

& EsD

2. Widget Weight Stretching
The example here demonstrates widget stretching. In this example, every clock widget

has different stretch weight values. The result every widget gains their proportion of
width as shown below -

- d Positioning
~ I Linear Yo
b Stretch 4

A Stretch
€ ESD Clock 4

Scroll Layout \

The Scroll Layout is a support runtime resizable and scrollable layout in ESD 4.10.

¥ [0 ESD Layouts ScrollPanel
P § Advanced Pointer
k Utilities
Fill Layout
7 Fixed Positioning —
Linear Layout Height
Scroll Layout ScrollX
Stretch i

— > Align
Switch Page O ScrollBars

TouchScroll
Scroll Bar Size

MinX

MaxX

MinY

MaxY

RangeX
RangeY

Width

Height

Scroll.. hanged
Scroll... hanged
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Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

ScrollX Getter and Setter for scroll value along X-axis
ScrollY Getter and Setter for scroll value along Y-axis
Align Set alignment for its child widgets

Scrollbars Set when scrollbar should be visible

TouchScroll Set true to enable touch scroll

To set scroll bar size when it is visible
Table 17 - Scroll Layout Properties

Scroll Bar Size

Scroll Layout Implementation

For the implementation of scroll layout, refer to the example project - “"EVE Screen
Designer > Examples > Intermediate - ScrollPanel.

Scroll Switch Page Layout

The Scroll Switch Page Layout jd 0 Layouts ESD Scroll Switch Page
consists of a switch page (dvanced Pointer
manager and a scroll panel for Utilities [ Initialise O

runtime scrollable support.

Scroll  Switch Page layout
requires 3 lazy page instances
and a current index to start with,
namely - the previous page
instance, the current page
instance and the next page
instance.

Upon user touch swipe event,
the page will switch according to
the swipe direction. The
behaviour of this scroll switch
page layout are as below:

e On non-swiping runtime, it
only renders the current
page, but runs the update
logic of all the 3 pages.

e On swiping event, it displays

both the current page and the
swiping to page (can be previous and next page instance).

Fill Layout NewPage []

xed Positioning
Linear Layout
Scroll Layout
Stretch
Switch Page
Scroll Switch Page

Initial Previ...
Initial Current
Initial Next
Initial Index
Active Scroll
Spinner

New Page
Active

X

Y.

Width

Height

Loop Pages
Count
Spacing
Sensitivity
Switch Speed

Previous Page
Current Page
Next Page
Current Index
New Index

Figure 58 - Scroll Switch Page Layout

e On touch up event, it will either recover to the original position if the swiped range
has not reached the minimum threshold or switch to the new page. The touch scroll
will be temporally disabled until it has recovered or switched to the target page.

e Upon switching page complete, the scroll switch page will fire "NewPage” event and
requests a new page instance to be allocated and assigns it as the "New Page” input.
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Property Name

Pointer
Initialise

Initial Previous
Initial Current

Description

The pointer reference of the widget object

The “initialise” slot for initialling the scroll switch page layout
Initial Previous page instance at start

Initial Current page instance at start

Initial Next Initial Next page instance at start

Initial Index Initial Current page index at start

Active Scroll Set true to override child widgets touch tag event where tag is
default(255)

Spinner Set true to show spinner upon loading the new page instance.

New Page New page instance input

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

Loop Pages Set true to loop the pages

Count Set pages count/limit

Spacing Defines the spacing between pages

Sensitivity Define the scroll switch sensitivity, range from: 0.05 to 20.00

Switch Speed
Previous Page
Current Page

Define the switch speed during page transition
The output of previous page instance
The output of current page instance

Next Page The output of next page instance
Current Index The output of current index
New Index The output of new index

Table 18 - Scroll Switch Page Layout Properties

Scroll Switch Page layout Implementation

In typical configuration for a scroll switch page layout, the figure below demonstrates a
sample setup. It should have the following rules:

e Connect start slot to the "Initialise” slot of scroll switch page layout instance.
e All switching pages should be configured as child widgets of Scroll Switch Page.

All child page widgets should be lazy allocation and has same width as the Scroll
Switch Page.

Initial Previous Page, Initial Current Page and the Initial Next Page should be
active by default while the rest of child pages should be inactive.

Initial index should be the index of initial current page.

Recommend using the “Switch” node to trigger the specific “Activate” signal of
the target page.

Recommend using the “Switch Value” node to get the specific target page
instances from all the pages.

Recommend adding header and footer pages which are Sibling widgets of the
Scroll Switch Page Layout instance.
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i} Page 5 Indica
B PageFooter

Figure 59 - Sample Scroll Switch Page Implementation

ESD Render Functions \

All render functions are non-widget. They are not E5D Render Functions
managed by layout in ESD 4.10. Non-widget functions I Elements

are to be used only within a widget. These functions are i Primitives
provided as utilities for user to make their own custom Display List

widgets. ESD Theme

Note: In order to preview the render functions result in design time, render slot in the
custom widget is required.

The Elements are both simple and basic widgets, usually
used to construct higher level and more complex widgets.
Normally, they do not handle any touch input.

Circle Sunken
ESD Gradient Panel
ESD Panel

ESD Panel Raised
ESD Panel Sunken

Figure 60 - ESD Elements
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ESD Circle

The Circle element allows the user to
draw circles on the screen. The
following styles are available - ESD
Circle Flat; ESD Circle Raised and ESD
Circle Sunken.

Figure 61 - ESD Circle Element

Property Name Description

Color RGB value to be rendered inside the circle
X x coordinate of central point, in pixels

Y Y coordinate of central point, in pixels
radius Radius of the point

Table 19 - ESD Circle Element Properties

ESD Panel

The ESD Panel is an adjustable rectangular
widget that defines a coloured area. The fiepe
colour can be specified by a theme or user’s *
selection. Internally, it is constructed by EVE
primitives RECTS and SCISSORS. Two styles
of ESD Panel are available namely - ESD
Panel Raised and ESD Panel Sunken.

Figure 62 - ESD Panel Element

Property Name Description

Theme Theme to be applied on the panel

X x coordinate of the top-left point, in pixels
y Y coordinate of the top-left point, in pixels
width Panel width

height Panel Height

radius radius of the corners

raised Set to true to make panel in raised style

Table 20 - ESD Panel Element Properties

ESD Gradient Panel

The Gradient Panel element is an BN

adjustable rectangular widget that

defines a gradient coloured area. The Y
gradient colour can be specified by two height
colours (one at start and one at the radius
end). The gradient direction is adjustable colorl

R . K color2
by changing the direction. P

ESD Gradient Panel

raised

Figure 63 - ESD Gradient Panel Element
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Property Name Description
X x coordinate of the top-left point, in pixels
y Y coordinate of the top-left point, in pixels
width Panel width
height Panel Height
radius radius of the corners
colorl Start colour for gradient effect
color2 End colour for gradient effect
direction Gradient effect direction
raised Set to true to make panel in raised style

Table 21 - ESD Gradient Panel Element Properties

Primitives ‘

A Primitive is a special type of logic node which is a
wrapper for a rendering function called by Render slot.
It has no return value and its properties cannot be
output to other logic nodes. Similar to widgets, it B8 ESD Bitmap Scaled

. N Esp Line {Integer)
_appetars on the screen, but is unable to handle user ESD Line (Fixed Point]
input.

| |
. ESD Rectangl
| |
| |

ESD Rectangl
ESD Gradient Rectangle (|

ESD Bitmap

The ESD Bitmap object allows users to display a [EEE]

bitmap resource. A bitmap resource is generated [l MRTGTGT=A

from an image file by adding it into a project. A
bitmap resource is treated as a single bitmap cell B ESD Bitmap Rotated

by default with the name “(Bitmap Resource)_0". B4 ESD Bitmap Scaled

. ESD Line (Integer)

W ESD Line (Fixed Point)

B ESD Rectangle (Integer)

. 50 Rectangle (Fixed Point)

For example, if the bitmap resource is named
“photo.jpg”, the default bitmap resource will be
named as “photo_0". Users can define how many
bitmap cells they want by specifying the
"CellHeight” property.

X

\(
Bitmap Cell
Color

Figure 65 - ESD Bitmap Primitive

Property Name Description

X x coordinate of Bitmap, top-left, in pixels
y Y coordinate of Bitmap, top-left, in pixels
Bitmap Cell Bitmap cell to display

Color Color to be applied to bitmap

Table 22 - ESD Bitmap Properties
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To add a bitmap

Properties

Click and select “File > Add” or click from the Pmp;zou,ceﬁ,epmj)va'ue
toolbar. A bitmap cell is then assigned. ESD File Name Ducati_side_shadow....
4.10 supports the following image file formats as input - R Sl
“.png”, “.jpg” and “.jpeg”. Bitmap resources can contain a f;;i"’y rrT
single or multiple cells based on the CellHeight value. Tt v True

CellHeight 0

If the value of the "CellHeight” is zero, then the number of ,ffwff"fs
cells is one. ersisten

If the value of the "CellHeight” is non-zero, then the number
of cells value is calculated as shown below -

Number of Cell = Bitmap Height / CellHeight

Library

Upon adding a Bitmap, the new bitmap resource will be
added into the Library under the category - “User
Resources”.

To use an ESD Bitmap, drag and drop the ESD Bitmap Node into the Layout Editor or
Logic Node Editor. —

~ [ ESD Primitives
= ESD Bitmap

B8 ESD Bitmap Rotated
B ESD Bitmap Scaled
. E:D Line {(Integer)

Choose a Bitmap Cell to display from the dropdown list.
Property Value

(ESD Bitmap)
Name ESD Bitmap

Active ¥ True

Depth Sort 1.00

x 296

¥ 164

Bitmap Cell Iml_0
b Color

The list of Bitmap Cell values is updated automatically after a new image file is added
into a project.
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a rendering function in ESD 4.10. Users are required to upgrade ESD Bitmap to

i j Use ESD Image to display bitmap as ESD bitmap is non-widget, and used only as
ESD Image from ESD 3.X.

ESD Line

The ESD Line allows users to draw lines on the ESD Line (Inteqger)
screen.

th

Color

Figure 66 - ESD Line

used only as a rendering function in ESD 4.10. Users are required to upgrade

i j Use ESD Widgets - Line Widget to display line as ESD line is non-widget, and
ESD Line to Line Widget.

Property Name Description

x0 x — coordinate of the start point, in pixels
y0 y — coordinate of the start point, in pixels
x1 x — coordinate of the end point, in pixels
yl y — coordinate of the end point, in pixels
Width Line width, in pixel

Color Line color, in RGBA format

Table 23 - ESD Line Properties
Fixed Point Variant

ESD Line (Fixed point) expresses the properties with pixel attribute in fixed point format.
It provides more control to lines.

ESD Rectangle

The ESD Rectangle allows users to draw ESD Rectanale {(Inteqer)
rectangle on the screen.

Color

Figure 67 - ESD Rectangle
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Property Name Description
X x coordinate of Bitmap, top-left, in pixels
Y Y coordinate of Bitmap, top-left, in pixels
width width, in pixels
height height, in pixels
radius radius of the round corner, in pixels
Color color of the rectangle

Table 24 - ESD Rectangle Properties

Fixed Point Variant

ESD Rectangle (Fixed point) expresses the properties with pixel attribute in fixed point
format. It provides more control to rectangles.

Display List

The Display List provides a collection of utilities functions
related to EVE Display List.

Figure 68 - ESD Display List

| ESD Theme
A Theme is a collection of colours which can be used across [ Themes
the application in order to maintain a consistent style. The
library browser provides the necessary logic nodes to make
most use of the theme function.

Logic Inte
User Actors

v w

&
|
2|
g
2|
g
2 |

Figure 69 - Library Browser - ESD Theme
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Built In Themes

ESD 4.10 provides two Built-in Themes for users to configure the colour scheme of
project. They are: Ft_Esd Theme_LightBlue theme and Ft_Esd Theme_ DarkOrange
theme.

eme_LightBlue.theme

* [ ESD Theme
* [ Themes
= Ft_Esd_Theme_DarkOrange
B Ft Fsd Theme LightBlue

Figure 70 - ESD 4.10 Built-in Themes

Table 25 and Table 26 provides information about the built-in themes property -

Property Name Type Value (RGBA) Description

Name String Theme Ft_Esd_Theme_LightBlue
ClearColor RGBA 235,235,235(255) Clear Color

BackColor RGBA 255,255,255(255) Background Color
TextColor RGBA 0,0,0(255) Text Color
ButtonTextColor RGBA 250,250,250(255) Button Text Color
DefaultColor RGBA 113,113,113(255) Default Color
PrimaryColor RGBA 34,119,199(255) Primary Color

Table 25 - Ft_Esd_Theme_LightBlue Theme

Property Name Type Value (Default) Description

Name String Theme Ft_Esd_Theme_DarkOrange
ClearColor RGBA 33,33,33(255) Clear Color

BackColor RGBA 21,21,21(255) Background Color
TextColor RGBA 255,255,255(255) Text Color

ButtonTextColor RGBA 255,255,255(255) Button Text Color
DefaultColor RGBA 107,107,107(255) Default Color

PrimaryColor RGBA 255,127,63(255) Primary Color

Table 26 - Ft_Esd_Theme_DarkOrange Theme
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To create a new theme:

File Edit Build Tools View Help

New P [ Logic
B Add B Actor
™ Save Ctr+S [ Widget

1. Click and select “File > New ->
Theme"”.
F
E!F'age
“® Theme
B SourceFiles
B Logic Source Files

New Project

Open Project

. : . . Property Value
2. A new "*theme” file is created within the Project (Linked File Pr
folder. Using the Property Editor, users can configure File Name yFavoriateTheme.theme
it as per their requirement. Name me

Cat

3. The newly-created theme will be available across the
project and may be applied it to other widgets with (ESD Label Button)
the theme property. T
Active Ft_Esd_Theme_DarkOrang

Theme Ft_Esd_Theme_GetCurren
X

Y
Width
Height 36

Font 27

Text Label Button
Primary v True

Ft_Esd_Theme_LightBlue

myFavoriateTheme

g
o
-

4. The newly created theme will also be available under
User Resources in the Library Browser. Users can drag
and drop the theme to the logic editor.

ESD Primitives
ESD Theme
ESD Utilities
SD Widgets
EVE Render Functions
(Hidden)
Logic Flow

Y Y YV VY VY VYY

n
‘ Logic Interface
ﬂ User Actors
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ESD Utilities |

ESD Utilities contains the collection ESD utilities functions. The
following table provides the

functionality.

ESD Utility

ESD BitmapCell GetlInfo
ESD BitmapInfo GetHeight
ESD BitmapInfo GetWidth
Bitmap Persist

Color A+RGB Combine
Clamp Float

Get Delta Ms

Get Font Height

Get EVE Host

Get Milliseconds

ESD Idle Checker
Clamp Int16/UInt16
Clamp Int32/UInt32
Load Bitmap to RAM_G
Load Palette to RAM_G
Pop-up Spinner

Switch Bitmap Cell
ESD Timer

Touch Area

Touch Scroll

Touch Tag

Current Tag

Suppress Current Tags
Touch X/Y

Touch X/Y Delta

v [ ESD Utilities
trnapCell Getinfo

Height

etWidth

list of ESD Utilities and its

Li

Load Palett

Pop-up Spinner
tch Bitmap Cell

@ ESD Timer

W Touch Area

« Touch Scroll

W TouchTag

N Touch X Delta
N Touchy

N Touch ¥ Delta
| | Clamp Ulnt16
N Clamp Ulnt32

Description

Retrieves the BitmapCell information with given bitmap reference.
Returns the BitmapCell Height of given bitmap reference.
Retrieves the BitmapCell Width of given bitmap reference.

To persist the given bitmap object

Merge Alpha to RGB, to become RGBA colour

Clamp float value with min and max limits

Get Delta time difference in milliseconds since last frame update
called

Return Font Height

Get EVE Host

Get time in milli-seconds for current frame

Check when to sleep and wake up based on the touch events.
Clamp Int16/UInt16 value with min and max limits

Clamp Int32/UInt32 value with min and max limits

Load Bitmap to RAM_G

Load Palette to RAM_G

Pop-up Spinner when the frame is rendered

Switch Bitmap Cell

ESD Timer Actor

Touch Area Actor

Touch Scroll Actor

Touch Tag Actor

Current Touch Tag

Suppress Current Tags

Touch X/Y coordinate

Touch X/Y Delta

Table 27 - ESD Utilities & Description
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ESD Idle Checker Actor provides an actor to check when the application should go to

sleep mode or wake
up from sleep mode.
One of the main use
cases of the idle
checker actor is to
check for idling and
wake up event for
displaying the
screen saver page.
The picture on the
right demonstrated
in "AppScreen.page”
uses Idle Checker to
switch between
application pages

Switch Page

Pointer

W' Switch Page
B Pages
B IdiePage

Pointer
Timeout [m}

O Waketip-E

Width
Height
Bitmap
Iding

IdlePage

Pointer

O
O

Width
Height

and the idle page. The idle checker has an interval of 250 ms and count of 60 intervals.
In other words, it may timeout when there is no touch event for 15 secs (60 * 250 =

15000 ms).

Logic Flow

A Logic Flow is an ESD built-in logic node. It is used to define |GGl

the logic or control flow and contains the following nodes:

= Condition

= Binary Condition
» [Local Method

= Binary Operator
= Ternary Operator
= Unary Operator
= Sequence

= Switch

=  Switch Value

= Set Variable

= Watch Variables

ESD Render Functions

F ESD Theme

ESD Utilities
50 Widgets
Logic Flow

} ndition
% Local Method

Binary Operator
Ternary Operator
Unary Operator
Sequence
Switch
Switch Value
Set Varniable

Watch Variables

User Actors
User Functions

User Pages

User

(5 o o o [ o o o ]

Figure 71 - Logic Flow
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 Condition

Library
| ESD Layouts
| ESD Render Functions
50 Theme
I ESD Ukilities
| ESD Widgets
Ln:ngic Flow
" Condition
Binary Condition
Binary Operator
Ternary Operator
Unary Operator

Condition node provides a set
of rules to be performed if a
certain condition is met. In
other words, it allows
applying decision points.

O Do
i

Sequence
5".!".1'i tc h
Switch Value
Set Vanable

"
"
-
L,
'
"

Watch Vanables

Figure 72 - Logic Flow — Condition Node

Whenever a condition node is called, a "Then” condition will be called when the "“If”
expression is True, otherwise an "Else” condition will be called.

Ensure that the input for the “If” connection is a Boolean variable (i.e. True or False).

Binary Condition ‘

Binary Condition node provides a set [EEgy

of rules to be performed based on the 8 ESDlayouts -

result of a binary operator on two | E?E?;‘:rjc_le_rFunctn:uns. D_u_ -

input values. In other words, it allows . E:ﬁ u;iirt?; EE:::U;:
- - . . L > :.I _u-

applying decision points. B ESD Widgets ght Value

Logic Flow
T Condition

" Binary (

Ternary Operator
Unary Operator
Sequence
Switch

Switch Value

Set Variable
Watch Variables

Figure 73 - Logic Flow - Binary Condition Node

Whenever a binary condition node is called, a "Then” condition will be called when the
result of binary operator on left and right value is True, otherwise an "Else” condition will
be called.

The binary operator is specified by user and it will be evaluated when the node is called
through “Do” input call.
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Local Method

Local Method node is used to add a visual function node. It works as a place holder
where user will provide input using parameters and put the function body in logic editor.
It gives the option to specify the no. of parameters, parameter type and parameter
name to the function as input. User can select the parameter count using scroll bar and
add parameters (type and name) from the properties tab.

Properties
Property Value
"l ESD Layouts (Local Method)
| ESD Render Functions Name Local Method
| ESD Theme Type int
ESD Utilities Buffered
| ESD Widgets Parameters
Lo.gic Flow 0)
[0]
(1]

(1
Function Body if(x>0 &8 x<=10)

False

Condition
Binary Condition
% Local Method
Binary Operator
Ternary Operator
Unary Operator Local Method

Sequence % Result

Switch
Switch Value
Set Variable if(x >0 && x<=10)
Watch Variables ) s ;-?
else if{x=>0 && x<=10)
Local Method y=2
Result else if{x>20 && x<=30)
y =3;
else if(x =30 && x<=40)
y=4
else
y =0;

Y

Figure 74 - Logic Flow - Local Method

e “Parameter Type” - Type of input parameter to be selected from drop down
menu i.e. int, float, char* or Ft_Esd_Theme* etc.

e "“Parameter Name” — Name of the variable should be according to ANSI C coding
standard.

e "Result” — Return value from this function which will be assigned to a variable or
input to new widget or assigned to output directly.
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Binary Operator

This node contains Binary Operator
that operates on two operands
(inputs) and manipulates them to
return an output. For example:
Result=Left Value * Right Value.

Library
| ESD Layouts =
| ESD Render Functions Left Value Result
| ESD Theme Right Value

L=

[+1 Binary Operator

Ternary Operator
Unary Operator
Sequence

witch
witch Value
et Variable
' Watch Variables

Figure 75 - Logic Flow - Binary Operator Node

The following table provides a list of binary operators supported by ESD 4.10.

Binary Operator

&&

Description

Equal to comparison operator
Not Equal to comparison operator
Logical AND operator

Binary AND operator

Logical OR operator

Logical OR operator
Multiplication operator
Division operator

Modulus operator

Binary XOR operator

Addition operator

Subtraction operator

Comma operator

Greater than operator

Less than operator

Greater than or equal to

Less than or equal to

Binary Left Shift Operator
Binary Right Shift Operator

Table 28 - Binary Operators Supported by ESD 4.10
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Ternary Operator

This node contains Ternary Operator
that operates on three arguments. B -

. . . = . Condition Result
First is the comparison argument; [ ESD Render Functions P

second is the result upon a true & ESD Theme vahe IFF e

Ternary Operator

comparison and the third is the result . EJB Ut"'“‘f
. L ELS

upon a false comparison. L= o
= Condition

For example: Result= condition Binary Condition

? “Value if true”: “Value if false”. inary
Ternary Operator
Unary Operator
Sequence
Switch
Switch Value
Set Variable
Watch Variables

Figure 76 - Logic Flow - Ternary Operator Node

Unary Operator \

. . Library
This node contains Unary Operator that |G ['] Unary Operator
operates on a single operand (input). g o
For example: ~. B ESD Theme

| ESD Utilities
S

Unary Operator

Sequence
Switch

Switch Value
Set Variable
Watch Variables

Figure 77 - Logic Flow - Unary Operator Node

The following table provides a list of unary operators supported by ESD 4.10.

Unary Operator Description

! Logic Negation
& Address of

* De-reference

+ Positive operator

Negative operator

~ One’s complement
1 Non-zero value converts to 1and other values converts to 0.
Table 29 - Unary Operators Supported by ESD 4.10
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“Sequence” node allows users REERE

Sequence
to define a series of calling Bl ESD Layouts
actions. When the “Do” input ¥l ESD Render Functions
call is invoked, the calls will be I ESD Theme
triggered sequentially. The 8 ESD Utilities
number of calls is specified by 5D Widgets Prope Velue
users in property “Count”. Enpchiu

Condition MName Seguence

T Binary Condition Count ]
M Binary Operator

M Termary Operator

M Unary Operator

Sequence

Switch

Switch Value
Set Variable
Watch Variables

Switch Node

“Switch” node will call different BESEE

branches based on the input B ESD Layouts

value, like a “Switch-Case” D Render Funchions

statement in C language. Users B ESD Theme

can define any number of B ESD Utilities

branches and the values to be B ESD Widgets

compared with input value Logic Flow Volue
through “Cases” property. =" Condition

Figure 101 shows an example of ' Condition Switch
3 branches defined and called

respectively if input value is Operator

equal to 1 or 2 or 3. Since, the Unary Operator

input value is pre-set to 4; the 4 Sequence

default branch is called if no " Switch

connection is made on it. Switch Value

Set Wanable

Watch Vanables

Figure 79 - Logic Flow - Switch Node
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“Switch Value” is a [MEEg Properties
node to select one B ESD Layouts Property Value
output  value from Bl ESD Render Functions (Switch Value)
multiple predefined | ESD Theme Mame Switch Value
values in  “Cases” B ESD Utilities
property based on B ESD Widgets int
input value, The Logic Flow
example in Figure 80 T Condition

4

shows 2 “Cases’
branch and property
“Cases” 0 defines such
logic: The “Result”
value is 4 if input
value is 1. Therefore,
the result value is 5
when the input value
3.

Binary Condition
Binary Operator
Ternary Operator

[N R S S Y

Unary Operator

Ln

Sequence
Switch

[+

]

Switch Value
Set Vanable

=t
N
.
N
__I

—_—
N
s
M Watch Variables

Switch Value

Set Variable

The Set Variable node is used REER]

to set the values of a variable. | ESD Layouts
It links an event call with a data B ESD Render Functions
binding to a Writer (output a Bl ESD Theme
functional call through “writer”) B ESD Utilities
or a Variable (sets a variable to | ESD Widgets

the value). Logic Flow
T Condition
y Condition

Ternary Operator
Unary Operator
Sequence
Switch
Switch Value
Set Variable

B Watch Yariables

Figure 81 - Logic Flow - Set Variable Node
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The Watch variables node is [eciatl Watch Variables
used to monitor a set of & ESD Layouts L Chedk Changed [
variable updates. A single | ED Render Functions [ Reset
watch variable node can — E‘g EL‘I'I“‘I:‘:
monitor ‘n’  number of | ESD .,u..,.idge,;'ﬂ_
variables which can be Logic Flow
different (primitive) types. =* Condition
However, the more the input " Binary Condition
variables have connected, Binary Operator
the more frequent the Ternary Operator
output “Changed” will be Unary Operator

Sequence
Switch

Switch Value
Set Variable
Watch Vanables

triggered. User can also
connect input slots:

Figure 82 - Logic Flow - Watch Variable Node

e "Check” - used to trigger an immediate check for the input variables against
previously checked values.

e “Reset” - set base values as current input values, and monitors changes from
there.

This watch variable could be very useful during the debugging, or multiple input trigger
events. It simplifies nested-if conditional flows.

Logic Interface \

A Logic Interface is an ESD built-in logic node. It is used [ReEEEl

to define an interface and contains the following nodes: & ESD Layouts
50 Render Functions

50 Theme

i ngt ESD Utilities
* Output B ESD Widgets
. S/gna/ Logic Flow
= Slot B Logic Interface
» Variable Input
= Writer E output
»  Widget Interface i 5:9”3|
= Slot
4’ Variable
..-'f, Writer
User Actors
User Functions
User Layouts
User Lnglc
Use
Use ources
Use
Figure 83 - Logic Interface
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The Input node is used to create an input interface for its parent logic node to bind
incoming data. For instance, while creating a widget, an input node will define a property
for the widget whose value depends on the connection. Users can configure its property
through the Property Editor.

Library

kB ESD Layouts
8l ESD Render Functions, Properties
| ESD Theme Property Value
| ESD Ltilities {Input)
| ESD Widgets Name Input
Logic Flow Meplay Mame

Logic Interface Comment

& Input Type
Output Edit Role

¥ Signal Min

* Slot Mazx

«" Variable Single Step

,,.i'":, Writer Default
Widget Interface

Figure 84 - Logic Interface - Input Node

The Output node is used to create an output interface for its parent logic to bind the
outgoing data. For instance, while creating a widget, an output node will define an
interface for the widget to display values to the users. Users can configure its property
through the Property Editor.

Library
b I ESD Layouts
¥ ESD Render Functions Properties
¥l ESD Theme Property Value
| ESD Utilities (Output)
5D Widgets Output
Logic Flow
c Interface
nput
Output

Display Name
Comment
Type

Value

...-"f. Writer
«" Widget Interface

Figure 85 - Logic Interface - Output Node
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The Signal node is used to create an outgoing event function call. Users can configure its
property through the Property Editor.

Library
k ESD Layouts
ESD Render Functions
ESD Theme
ESD Utilities
ESD Widgets Properties
Logic Flow Value
Logic Interface L
& Input Name Signal
Output Display Mame
Signal
Slot
Yariable
. Writer
Widget Interface

Figure 86 - Logic Interface - Signal Node

Sl

The Slot node is used to create an incoming event function call.

Library
ESD Layouts
ESD Render Functions
ESD Theme
ESD Utilities
ESD Widgets
Logic Flow
d Logic Interface Signaled
& Input
E Output
¥ signal
- Slot
' Variable
..-'f. Writer
# Widget Interface

Figure 87 - Logic Interface - Slot Node

Built-in Slot

There are a number of built-in slots available for Widgets, Pages and Applications which
are automatically called through the node hierarchy. The following table provides the list
of built-in slots.
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Built-in Slot
Start
Render

Update
Idle
End

Description
Called when the node is created in memory

Writing rendering calls to the co-processor command buffer. It is
repeatedly called.

Called once before the frame render. It is called frequently.
Called repeatedly while waiting for the frame to flip
Called when the node is removed from the memory

Table 30 - Built-in Slots
The following pseudo-code may help you understand how these slots are invoked:

//Bpplication is booting up and started
Start ()
//Now UI is launched
while (UI is running)
{

Update () ;

Render () ;

Idle () ;
}
//BApplication is ending
End ()

Variable

The Variable node is used to define a plain C variable. Users can drag and drop the
Variable from the Library browser to the logic node editor and configure its property
through the Property Editor.

Library Variable
B Esp Layouts
ESD Render Functions
ESD Theme
ESD Litilities
ESD Widgets Property Value

Value
Properties

gic Flow (Variable)
ic Interface Mame Variable

Input Display Mame

Output
signal
= Slot Type

Variable Edit Role

. Writer Min

Comment

Accessible from outside

Widget Interface Maz the node

Single Step
Value ReadOnly

Accessible from outside
the node with no write

Only accessible from its

owner (Default)
Property Editor

Figure 88 - Logic Interface - Variable Node
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Writer

The Writer node is used to define a value writing interface |ieakatd co L
50 Layouts

for its parent node. Generally, it is used to setup the value S )
. . . . ESD Render Functions
for the external variable. For instance, while creating the T ESD Theme
ESD Spinbox widget, the “Changed” writer is defined to B ESD Utilities
update the connected external variables of Spinbox widget B ESD Widgets
once Spinbox value is changed. m Logic Flow
B Logic Interface
1 Input
Output
Signal
Slot
Varnable
. Wniter
Widget Interface

Widget Interface

The Widget Interface node [N TS uRN——-. BT
shows the interface of base o - Pointer

idaet interf Si ESD 5D Render Functions S
widget Interrace. since SO Theme I._.-_nr-|13|rn:r
4.0, all layouts, pages and SD Utilities Active
widgets have been SD Widacts Local X
implemented from this Lj P Local Y

| - ogic Flow "
widget interface. For Logic Interface Local Width
advanced  users this -ogic Interface Local Height

- - ! i Input =
widget interface node could Outout Local Rect
be useful for designing user i r1Fa| Global X
customized widget in order ;lit Global Y
to use its base interface for e Global Width

. . . Variable [

accessing information from  \Writer Global Height
ESD widget framework. S Global Rect

Widget Interface

Figure 90 : Widget Interface

Property Name Description

Pointer Provides the pointer of this widget, allow other widget/layout/page to refer

Container Provides the pointer of this widget’'s immediate container. Normally, a
widget’s immediate container is a layout

Active Set and get the current widget active

Local X Set and get the current widget local X. Local X refers to the local x-coordinate
with reference to its container

Local Y Set and get the current widget local Y. Local Y refers to the local y-coordinate
with reference to its container

Local Width Set and get the current widget local width. Local width refers to the designed
width with reference to its container

Local Height Set and get the current widget local height. Local height refers to the
designed height with reference to its container

Local Rect Set and get the current widget local dimension with reference to its container

Global X Set and get the current widget global X. Global X refers to the global x-
coordinate with reference to screen

Global Y Set and get the current widget global Y. Global Y refers to the global y-

coordinate with reference to screen
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Global Width Set and get the current widget global width. Global width refers to the
designed width with reference to screen
Global Height Set and get the current widget global height. Global height refers to the
designed height with reference to screen
Global Rect Set and get the current widget global dimension with reference to its screen

Table 31 - Widget Interface Properties

Advanced users are encouraged to refer the example project “WindowLayout”
for details.

x ' N

e All Local properties are subjected to difference from the respective Global
properties. As the global values are determined by the layers of the layouts
as containers.

e Global properties are the values determined at the runtime. While Local
properties are values determined at design time.

e Global properties are eventually stable in runtime, as layers of layouts may
require multiple rendering cycle to stabilize.

Product Page 96
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

)

\/
o Brid k BRT_AN_029 EVE Screen Designer 4.10 User Guide
%’ rl ge'te Version 1.0

* BRIDGING TECHNOLOGY

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Property Editor \

The Property Editor provides user a unified interface to |ikuskss

edit properties. Each logic node in ESD 4.10, including a [&&&es WValue
widget, has its own predefined properties. Users can edit B
the property values using the Property Editor to Name

customize logic nodes. Depth Sort

Active

. . Theme Fi_Esd_There_GetC...
The sample picture given below shows an example of the i o

ESD 4.10 widget “ESD Radio Button”. - 0
Width 20
Height 20
Font 27
Text Option

Figure 91 - Property Editor

Common Properties \

While each widget has its own properties defined for its own specific features, the
following are some of the properties that are commonly found in all the widgets of ESD
4.10 application -

= Name
= Depth Sort
= Active

Properties

Property Value

Value
(ESD Radio Button)

Name ESD Radio Button
Depth Sort

ESD Slider
0.00
v True

Theme Ft_Esd_Theme_GetC...
X 10
Y 10
Width 160
Height 20

Active

Theme Ft_Esd_Theme_Get(..
X 0

¥ 0

Width 0

Height 20

Font

Text Option

Alpha 255

WValue 0

Range 100
Figure 92 - ESD Common Properties

Product Page 97
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.0

)

\/
o { Brldgetek BRT_AN_029 EVE Screen Designer 4.10 User Guide
(4

. .
A BRIDGING TECHNOLOGY Version 1.0

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Name

Each node must have one unique name as an identifier. EEEs
Users are required to define a name that is valid C [l Value
identifier, since these names will be used by ESD for )
generating the source code. L ESD Slider

Depth Sort 0.00

Active v True

Theme Ft_Esd_Theme_Get(C...

X

v

Width

Height

Alpha

Value

Range

Depth Sort

Each widget and page has one common property
called Depth Sort. 1t is of floating point type, and
defines the sequence of rendering. The default value Name ESD Slider
is “0.00” and users may change it accordingly to : 0.00
adjust the sequence of the rendering process. ull T
Theme Ft_Esd_Theme_GetC...
X 10
¥ 10
Width
Height 20

Alpha

Value

Value 0

Figure 94 - Depth Sort Property
|
The context menu helps users adjust the rendering
sequence without dealing with the values and can be
accessed within the layout editor by selecting the -
widget or page and right-clicking it. Bring to Front

Bring Forward

S5end Backward

5end to Back

Figure 95 — Right Click Menu

The widget or page with the greatest positive "Depth Sort” value will be rendered last
and appear on the topmost layer.
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Active

Each widget has one Active property of Boolean type REELE

which controls whether or not it is rendered on the [EEEL] Value
screen. Active property in false state does not mean that e

the widget is released from the memory. Instead, it
means that the widget is not rendered on the screen, but
still is part of the memory.

ESD Slider
0.00

¥ True
Ft_Esd_Theme_GetC...

Width
Height

Alpha

Value

Range

Figure 96 - Active Property

« © ¥ Users must ensure that the NAME property follows the standard C identifier
syntax in order to make the generated source code more readable.

Programming Features

This section explains about the programming features. ESD 4.10 enables users to write C
code and make this code available in the form of logic nodes so that the code can be re-
used across multiple projects.

Macros

In order to provide the development environment with necessary information about the
available functionality in a user’s code, ESD 4.10 provides a set of macros. These macros
are necessary and useful when users add their own code that needs to be used from the
logic node editor or layout designer.

These macros are generally used together with the source code. It is recommended that
the user defines all the definitions associated with macros immediately following the
macros declarations where ever needed and in the same file. Not doing so, may result in
unexpected behaviour. For e.g., ESD_FUNCTION macro immediately needs to be
followed with function definition. Comments are acceptable between the macro and the
definitions.

ESD_TYPE

ESD_TYPE provides information about a primitive type. All types are assumed to have a
default value of 0.

Syntax Example:

ESD TYPE(ft uint32 t, Native = UInt32, Edit = Int)
ESD TYPE (char *, Native = Latinl, Edit = String)
ESD TYPE (Esd BitmapCell *, Native = Pointer, Edit = Library)
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Parameter Type Parameters

Description

Native Type used internally for formatting C literals and
binary representations
Void Not a type (default)
Int64, Int32, Intl6, Int | Signed integer
8,IntPtr
UInt64, UInt32, UInt16, @ Unsigned integer
UInt8, UIntPtr
Double 64bit floating point
Float 32bit floating point
Char An 8bit text character
Bool C99 Bool
utf8 String with UTF-8 encoding
Latinl String with Latin 1 (ISO8859-1) encoding
Pointer Pointer type
Struct Struct type (not fully supported yet)

Edit Used by the Properties Editor to specify the control
to edit the value and by code generation when
using the fixed point formats

None No editor control (default)

Int Integer, spin-box integer control

Real Floating point, spin-box floating point control
Boolean One or Zero, checkbox

String Text, single-line entry

Fixedl, Fixed2, Fixed point, spin-box floating point control

..., Fixed32

ColorARGB Color, rgb with alpha

ColorRGB Color, rgb without alpha

Library Select a function specified with ESD_FUNCTION to

provide the value (useful for pointer values)

Table 32 - Macros — ESD_TYPE - Parameters

ESD_ENUM

Enumeration types are usable as types from the logic editor. It will use the specified
Type in the generated code. Internally, only the enumeration identifiers are parsed;
values are ignored. Enumerations used in the properties are serialized as their identifier
string. Enumerations are edited using a drop-down control in the Properties Editor.

Syntax Example:

Using pre-processor definitions, the symbol right after each #define statement is used.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
#define PALETTED 8UL
#define PALETTED4444 15UL
#define PALETTED565 14UL
#define PALETTEDS 16UL

ESD_END ()

Parsing from an enum requires the identifiers to be on separate lines, the first identifier
of each line is used.

100
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ESD ENUM(Ft BitmapFormat)

enum Ft BitmapFormat

{
PALETTED,
PALETTEDS565,
PALETTEDS

¥
ESD_END ()

In case the enumeration is defined in another file, a macro is available to manually
specify the identifiers.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
ESD IDENTIFIER (PALETTED)

ESD IDENTIFIER (PALETTEDS565)

ESD_END ()

When the Flag value is specified, the enumeration can combine multiple values, and will
show as a series of check-boxes in the Properties Editor instead of a drop-down menu.

ESD ENUM (Ft CoPro Opt, Type = ft uintlé t, Flags)

#define OPT CENTERX 5120L B

ESD END()

To allow users to select 0 as a valid value, the Zero flag can be set. This flag has no
effect when the Flag value is specified.

ESD_FUNCTION

ESD_FUNCTION is a macro to register a user defined function Li:'ral
to ESD 4.10, so that the application can add that function into — )

. . . . ESD Render Functions
the User Functions category node which is located in the ESD Theme
Library browser. ESD _FUNCTION is not applicable for static ;D Utilities
functions even though ESD permits to make any function with 5D -..~..-i,jgeg5_

ESD _FUNCTION macro. “m Logic Flow

Logic Interface
User Actors

User Pages
User Resources
User Widgets

Figure 97 - User Functions Example
Syntax Example:
The following syntax example is to register a function called "hsvToRgb” to ESD 4.10.

ESD FUNCTION (hsvToRgb, Type = ft argb32 t )

ESD PARAMETER (h, Type = double)

ESD PARAMETER (s, Type = double)

ESD PARAMETER (v, Type double)

ft argb32 t hsvToRgb (double h, double s, double v)

Upon registering the function, it is added to the User Functions category.
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Parameters Description
Type The function’s return value type

Table 33 - Macros — ESD_FUNCTION - Parameters

e Each ESD_PARAMETER defines only one function parameter. It must
be kept in a single line for each parameter.

o “Buffered” flag can be attached after togglelED
“Type”. It will create the output of the [HE=l
NOTE function stored in a member variable,
whenever the function is called.
Without the Buffered flag, you'll have a
function with just one output value which is called whenever the
output value is used. Here is an example:

ESD FUNCTION (toggleLED, Type=int,Buffered)
ESD PARAMETER (state, Type=ft bool t)

ESD_METHOD

ESD_METHOD works similar to ESD_FUNCTION with an enhanced feature. It takes a
logic/actor/widget/page/app context pointer as first parameter. It can be used only
within the logic editor of that logic/actor/widget/page/app.

Syntax Example:

The following syntax example defines one method to handle “Pushed” event for an ESD
Push Button widget contained in “MainPage.page”.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed(MainPage *context)
{
//
}

The logic node connection and the corresponding output is shown in the sample picture
below -

|

ESD Push Button Pushed

O
@ cal

LE

¥
Width
Height
Font
Text
Primary

Pushing

Figure 98 - ESD_METHOD Example
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Parameters Description
Context Pointing to the caller’'s context

Table 34 - Meta Macros — ESD_METHOD - Parameters

e Additional parameters can be defined similar to ESD_FUNCTION. But
these parameters must be added only after the Context parameter.
Here is an example:

NOTE

ESD Push Button Pushed

ESD METHOD (MainPage ESD Push Button Pushed, Context =
MainPage)
ESD PARAMETER (test,Type = ft bool t)
void MainPage ESD Push Button Pushed(MainPage
*context, ft bool t test)
{
//
}

e If the return value of method function is to be defined, “Buffered”
keyword needs to be added after the “Type” definition. Refer to the
syntax example -

ESD METHOD (MainPage ESD Push Button Pushed, Context =
NOTE MainPage, Type=int, Buffered)

ESD PARAMETER (test,Type = ft bool t)

int MainPage ESD Push Button Pushed(MainPage

*context, ft bool t test)

{

/7
}

ESD_VARIABLE

ESD_VARIABLE is a built-in macro used to define a local variable of a logic node.
Syntax Example:

ESD VARIABLE (Margin, Type = ft intl6 t, Default = 0, Public)
ft intl6_t Margin;
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ESD_GLOBAL

ESD_GLOBAL is a built-in macro used to define a global variable accessed across
different pages of a logic node. Global variable declaration should present in the header
file and definition should be in source file.

Syntax Example:

ESD GLOBAL (Var, Type = int)
extern int Var;

ESD_INPUT

ESD_INPUT is a built-in macro used to define an input variable of a logic node.
Syntax Example:

ESD INPUT (Margin, Type = int)
int (* Margin) (void *context) ;

ESD_OUTPUT

ESD_OUTPUT is a built-in macro used to define an output variable of a logic node.
Syntax Example:

ESD OUTPUT (FirstPos, Type = int)
int LayoutSplit FirstPos(LayoutSplit *context);

ESD_UPDATE

ESD UPDATE macro is used to register a function that is called repeatedly by built-in
“Update” slot. This function shall not have any return value.

Syntax Example:

ESD UPDATE (Ft Esd BitmapPersist)

ESD PARAMETER (bitmapCell, Type = Ft Esd BitmapCell *)
void Ft Esd BitmapPersist (Ft Esd BitmapCell *bitmapCell);

Parameters:

Users can define their own parameter used by the registered function by using the
ESD_PARAMETER.

Pre-compiler options

Within the ESD C code simulation engine, the following macros are predefined in
generated source code:

e ESD SIMULATION
e FT900_PLATFORM
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ESD_SIMULATION

ESD_SIMULATION macro is defined when the code is running through the ESD
simulation engine. If some part of the user’s C source code is not supposed to be run
under the ESD simulation engine, for example, accessing some hardware specific
registers, users may choose to skip the code by using this macro.

FT900_PLATFORM

FT900_PLATFORM macro is defined when the target platform is FT90X based. It can be
set when the ESD_SIMULATION macro is defined.

Add User Functions

Users can define their own functions by writing the C source code directly. If these
functions are defined by using the predefined "ESD_FUNCTION”, they will be shown
under the “User Functions” category in the library browser. Users can drag and drop
these nodes into the logic node editor to use them.

Creating Source File

To add user functions, users need to create a
C source file by clicking File > New - or
Source Files. : cri+s Bl Widget

M Page

‘B Theme

H Source Files

B Logic Source Files

Upon adding the source file, include the following header (mandatory) in the source
file.

#include "Ft Esd.h"

Editing the Source File

To make ESD responsive of the user functions, the ESD specific macro "ESD_FUNCTION
or ESD_METHOD” need to be added before the function definition. Refer to the examples
given below -

Syntax Example:

= Without parameter input and return value

ESD FUNCTION (BulbPage TestFunc)
void BulbPage TestFunc () {}
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BulbPage_TestFunc

Call

=  Without parameter input, but with the return value

ESD FUNCTION (Ft Esd Theme GetCurrent, Type = Ft Esd Theme *)
Ft Esd Theme *Ft Esd Theme GetCurrent();

Current Theme

=  Without return value defined, but with the parameter input
ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)

ESD_PARAMETER (theme, Type = Ft Esd Theme *)
ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme) { //.. }

fu_ CoCmd_FoColor

=  Without return value and parameter input

ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)
ESD PARAMETER (theme, Type = Ft Esd Theme *)

ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme)
{

// ..
}
Get Button Text Color
theme
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